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Introduction 

What is SpinWorks 
SpinWorks has two functions: The first is to provide easy basic off-line processing of 1D NMR 
and 2D data on personal computers. SpinWorks other function is the simulation and iterative 
analysis of complex second order spectra including dynamic NMR problems and certain solid-
state NMR problems, in a manner similar to our UNIX Xsim program.  

SpinWorks 2.5 is the fifth release of SpinWorks version to contain 2D processing.  Full support 
is included for Bruker (XwinNMR/UXNMR) and Varian (Unix VNMR) data formats.  Included 
F1 detection modes include States, TPPI, States-TPPI, Single Detection (QF), and echo-antiecho. 
Limited 2D support is provided for Tecmag data. 

While the program is to the point where it should (I hope) be useful, there will, no doubt, be bugs 
and there are things that don't yet work. The aim of the program is to make a program easy 
enough for undergrads to process magnitude COSY spectra (for example) with a single mouse 
click, and yet still be flexible enough for research use. 

SpinWorks currently handles only one data set at a time.  However, most new computers have 
sufficient memory to run two or three copies of SpinWorks simultaneously.  This can be very 
useful when examining the rows and columns of a 2D data set. 

Things that don't yet work or need improvement: 

1. As always, the manual and help files aren't quite up to the level of the software.  I like 
writing code a lot better than writing help files.  In particular, the dialog pictures in this 
manual may not be quite up to date with those in the latest release. 

2. In 2D mode, the program is a bit of a memory hog.  This is because all of the data remains 
memory resident.  This does, however, greatly speed up the processing.  Future versions may 
store imaginary data on disk after transform and phasing.  2D SpinWorks is currently about 
20% faster than XwinNMR on the same computer.  2D matrices up to 2k by 1k shouldn't 
create problems on a machine with 64 MB of ram.  You may want to watch how many other 
apps you have running, however. A 4k by 1k TPPI HSQC uses up about 32 MB of memory 
on my 256 MB machine.  Considerable additional memory is used transiently during 
transform and display contouring.  

3. Not enough OS/printer/printer-driver combinations have been tested.  In particular, I would 
like to hear from anyone having printing problems with Win XP. 

4. 2D MQMAS shearing transforms still need to be tested Bruker data. 

5. There has been a report of SpinWorks not being able to find the dynamic NMR modules 
when running on some configurations of Win XP.  I have not yet been able to reproduce this 
problem. 
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Sample 2D transform timings (with image mode display) on a 1.7 GHz 256 MB P4 under 
Win2000:  

• 4k by 512 States HSQC with phasing applied in F1:      6 sec. 

 Comparison: XwinNMR 2.6:    7 sec. 

 Comparison: VNMRJ, Sun Blade 150:    14 Sec 

• 1k by 1k States TOCSY with phasing applied in F1:  ca 2 sec. 

• Contour display of 1k by 1k TOCSY (Strychnine):    ca 2 to 3 sec. 

What does the message “Display buffer exceeded, raise the floor!” message mean: 

It means that the lowest display level (contour or image) is too low.  Simply click the Floor + 
button (2D Processing and Display dialog).  You may have to click several times is the level 
was much too low. 

Computer Requirements 
SpinWorks requires a 486 or higher processor (Pentium recommended) running Windows  NT 
4.0, Windows 2000 Pro or Windows XP. Windows 95, 98 and ME are probably O.K., but are 
untested. Installation currently requires about 7 Mbytes of disk space exclusive of NMR data.  32 
Mbytes or more of RAM are recommended, depending on NMR data set and simulation sizes.  
SVGA 800 x 600 or better display required (1024 x 768 or better recommended).   

For 2D processing a Pentium class processor with 64 Mbytes of memory is the practical 
minimum.  

For 2D you should also have your display set to at least 16 bit colour, otherwise the image and 
contour level colours will be strange.  

I have received reports (but have not confirmed) that SpinWorks will run under Linux with the 
WINE package and on a Mac with SoftWindows. 

A three-button mouse is ideal, but SpinWorks will work just fine with a two-button mouse.  Note 
that on "Wheel Mice" the mouse wheel also serves as the middle mouse button.  The mouse 
wheel can also be used for vertical scaling of 1D spectra. 

Download 
The program is currently available by anonymous ftp from ftp://davinci.chem.umanitoba.ca in 
the pub/marat/SpinWorks directory.  The current release is SpinWorks_2.4_PL5.zip.  The 
documentation, available as a pdf file, is available for separate download, but is also included in 
the zip distribution. 

Installation 
Run the setup.exe program in the unzipped folder and follow the instructions.  In most cases, it is 
safe to use the default settings.  The installation procedure will add the program to the Start 
menu and it is an easy matter to make a shortcut on the desktop.  Please read the license 
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agreement and agree with the conditions before proceeding. 

Note that each new version of SpinWorks will have its own registry entries.  This means that you 
will probably want to go to the Options menu and use the Set Preferences… dialog to configure 
you start-up preferences.  Usually, this will mean just setting your start-up data path and a few 
desired defaults… a few seconds at most. 

Redistribution 
You are free to redistribute this software to others, provided that: 

• You don’t charge anything for it. 

• You don’t modify it. 

• You distribute it in its entirety. 

Registration 
Although SpinWorks is currently being distributed as Freeware, and there are no license keys or 
“dongles” required, I do, however, request that a SpinWorks user register their use by email to: 

kirk_marat@umanitoba.ca   

Please include: an email contact, the machines and OSs that you are running it on (e.g. Pentium 
266 Win 98), and a note of any problems etc. that you had with the download and installation.  I 
intend (someday) to maintain an email list so that I can inform users of bugs, updates, patches, 
etc.  If you don’t want to be on this list, please let me know. 

More detailed comments, questions, bug reports, etc. can be also directed to the above address, 
and are always appreciated. 

Acknowledgements 
Many people have helped with the design and testing of SpinWorks and the older UNIX Xsim 
program, providing numerous bug corrections, suggestions and test data.  I would especially like 
to thank: Alex Bain, Klaus Bergander, Woody Connover, Mike Coplien, Klaus Eichele, Mike 
Englehardt, Phil Hultin, Vera Mainz, Virginia Miner, Gareth Morris, Rudy Nunlist, Georgy 
Salnikov, Rich Shoemaker, Jian-Xin Wang and David Vanraes.  My apologies to anyone I may 
have missed. 

Obligatory Disclaimer  
The author disclaims all warranties with regard to this software, including all implied warranties 
of merchantability and fitness. In no event, shall the author or the University of Manitoba be 
liable for any special, indirect or consequential damages, or any damages whatsoever resulting 
from loss of use, data or profits, whether in an action of contract, negligence or other tortuous 
action, arising out of or in connection with the use or performance of this software.   

All trademarks mentioned (e.g. XwinNMR, VNMR(J), Windows, etc.) are property of their 
respective owners. 

mailto:spinworks@visar.chem.umanitoba.ca
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Online Help 
Standard Windows type context-sensitive help is available.  Most of the help files are extracted from 
this manual, but may not be complete.  As of version 2.2, this manual is available from the help 
menu as a pdf file. 

What’s New in Release 2.4 
1. 2D integration has been added. 

2. SpinWorks is now much better at determining the F1 detection mode for Varian data.  It also 
tries to figure out, usually successfully, whether the F1 dimension should be reversed. 

3. SpinWorks automatically detects the data format for Varian (VNMR) and Bruker 
(UXNMR/XwinNMR) data. 

4. The interface for displaying 1D traces and external spectra on the 2D display has been 
improved and automated a bit. 

5. It is possible to display projections as external traces of 2D spectra. 

6. SpinWorks can now automatically determine whether the data are Bruker 
(XwinNMR/UXNMR) or Varian (VNMR) format. 

7. FIDs can be right-shifted by using a negative left-shift parameter. 

8. 2D Spectra can be displayed and printed with the F1 dimension horizontal, if desired. 

Added or fixed at PL5 
1. 1D stacked spectra can now have different offsets, spectral widths or even B0 fields. 

2. A button to return to a previous expansion has been added. 

3. Peak picking has the option to select positive only, negative or both positive and negative 
peaks. 

4. Axis font size can be changed from default (within limits). 

5. The ceiling button of the 2D Processing and Display dialog has been changed to a range 
button.  The “ceiling” or highest level now tracks the “floor” or bottom level. 

6. The 1D Processing parameter panel has been re-organized. 

7. A “shearing transform” for 2D MQMAS has been added.  Please contact me if you need help 
with this.  I would especially like to hear from people that have tried the algorithm on Bruker 
MQMAS data, as I have only Varian MQMAS data available. 

8. The maximum number of contours segments has been significantly increased. 

New in Version 2.5 
1. Fixed a referencing bug with Varian data that occurs when the rfp (or rfp1, rfp2… etc.) 

parameter is not zero. 



2. Bias correction of the FID is now an option parameter, with a default value of off. 
3. JEOL data are reversed automatically after transform. 

4. For Varian data, the program now looks at the block header rather than the file header in 
order to determine whether the data are 16 bit vs.32 bit.  There seems to be some problems 
with LINUX VNMR data where the file header will describe the data as 16 bit (dp =’n’) but 
the data are actually 32 bit (dp = ‘y’). 

Use of the Mouse, and General Display Manipulation 
While the cursor is in the data window, the mouse can be used to mark one or two red reference lines 
on the spectrum.  A third click will remove the lines. The frequency and frequency difference of 
these lines is displayed on the screen and can be used to estimate shifts and couplings, etc.  These 
lines are also used by several routines that require defined reference points.   

The right mouse button (on both two- and three-button mice) is used to assign calculated transitions 
to observed lines, but only when the pointer is actually within the data window (the part of the 
screen displaying the spectra).  This is somewhat counter to standard Windows behavior, but is 
consistent with Xsim and I couldn’t figure out a better way to do it.  

In 2D mode the right mouse button selects rows or columns of the 2D matrix (e.g. for phasing). 

Spectral regions can be zoomed by defining two reference points and clicking the blue  button 
on the toolbar, or the middle button of a three-button mouse.  Spectra can also be expanded and 
contracted with the buttons labeled < > and > <. A tracking vertical cursor line can be turned on/off 
with the appropriate selection in the Options menu. The scrollbar at the bottom of the data window 
can be used to pan through an expanded spectrum.   A number of specific display limits or plot 
scales (e.g. 9 to -0.5 ppm or 10 Hz/cm) are available through the View menu.  The toolbar Full 
button will always show the full recorded spectral width. 

1D Spectra are scaled vertically with the toolbar + and – buttons. The black buttons are for the 
experimental spectrum and the blue buttons are for the simulated spectrum.  Spectra may also be 
scaled in smaller steps with the keyboard up and down arrow keys.  The toolbar up and down arrow 
keys are used to shift 1D spectra vertically. 

It is possible to expand a region of a 1D spectrum and display it is a separate inset box.  Simply 
define the region with the cursors and click on the  button on the toolbar.  The cursor-defined 
region will be displayed in a re-sizable box and a dialog box for scaling the inset will be displayed as 
well.  The inset trace can be turned off and back on at any time with the Show Inset Box selection 
in the View menu.  Likewise, the button panel controlling the scaling of the inset trace can be closed 
and then re-opened at any time with the Scale/Shift Stacked or Inset Traces… selection in the 
View menu.  Note that the vertical scaling of the inset is completely independent of the regular 
spectrum scaling, but the relative scaling of the two is always shown on the inset just above the axis. 
 The relative scaling of the inset can be set to be the same as the regular spectrum by using the reset 
button on the Scale and Shift Stacked or Inset Traces dialog box. 

Up to three regions of interest (regions that you might want to look at again) may be defined for each 
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spectrum.  You can define these regions with the Define User Specified Limits… dialog from the 
View menu, and the saved region can be displayed with the ROI menu.  You can also use <ctrl>1, 
<ctrl>2 or ctrl<3> to define the current screen view as a region of interest.  The regions can then be 
recalled with the ROI menu or the 1, 2, or 3 keys.  These regions of interest are saved with 
processed data saved by SpinWorks (when the autosave feature is on) and recalled when the data is 
retrieved.  These regions are not saved with data in JCAMP-DX format. 

 

Keyboard Arrow Keys 
The keyboard left and right arrow keys move the simulated spectrum transition cursor from peak 
to peak.  Holding the <ctrl> key down while pressing the arrow keys moves the cursor in steps 
of 5.  This is very useful for moving the cursor rapidly on a spectrum with many degenerate or 
near degenerate transitions.   

The keyboard up and down arrow keys adjust the vertical scale of the experimental spectrum.  
The scaling steps are smaller than those of the toolbar + and – buttons.  Holding the <ctrl> key 
down while pressing the arrow keys scales both the experimental and calculated spectra. 
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Keyboard Function Summary 
Left and Right arrows  Move the simulated spectrum transition cursor.  Holding the 

control key down at the same time moves the cursor in steps of 5 
transitions 

Up and Down arrows Adjust the vertical scaling of the experimental spectrum.  Holding 
the control key down at the same time adjusts the scaling of both 
the experimental and simulated spectra. If you have a "Wheel 
Mouse", you can use the mouse wheel to adjust the vertical scaling 
of 1D spectra.  If the pointer is in the bottom half of the data 
window the scale of the experimental spectrum will be adjusted.  If 
the pointer is in the upper half of the screen the scaling of the 
simulated spectrum will be adjusted. 

“t”  key   Toggles the tracking cursor (2D cross-hair pointer) on or off.  This 
is an alternative to using the Options menu.  Double clicking in the 
data area will also do this. 

“r” key    Refreshes the display. Occasionally, the tracking cursor or the 2D 
cross-hair cursor can leave behind marks on the screen if it has been 
covered by a dialog.  To remove these traces simply hit the “r” key. 
 As of release 2.3, much of this problem has been fixed, and the “r” 
key should rarely, if ever, be needed. 

“a” key                       Assigns the transition pointed to by the transition cursor to the 
nearest observed line.  This function uses the peak picking 
algorithm, so is influenced by the peak picking threshold and noise 
discrimination factor. 

 “d” key                        Deletes any assignment for the currently pointed to transition. 

<ctrl>1, <ctrl>2, <ctrl>3 Defines the currently display as a region of interest that can be
 recalled later.  You can also define these regions from the View 
 menu. 

“1”, “2” or “3” keys  Recall a previously defined region of interest.  The ROI menu 
 from the menu  bar can also be used. 

Toolbar 
The toolbar is displayed across the top of the application window, below the menu bar. To hide 
or display the Toolbar, choose Toolbar from the View menu. The toolbar is “dockable”, 
meaning that it can be moved to any convenient location. The toolbar provides quick mouse 
access to many tools used in SpinWorks: 
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•  Open an existing NMR data set.  SpinWorks displays a dialog for selecting data 
sets.  



•  Print the current NMR spectrum. 

•  Save the processed spectrum in JCAMP-DX format in the current data folder.  
The file will be named: “spectrum.dx”.  In order to save the pale with a particular 
name, use the Save As… selection in the File menu.  This button is most useful for 
saving 1D reference spectra to plot along the axes of 2D spectra. 

• The  buttons Zoom the spectrum between red two cursor lines, 
Clear the cursors, return to the full spectral width, or return to the previous expansion, 
respectively.  Note that if you have defined a region with two cursors lines, you can 
use the middle mouse button (if you have one) to zoom in place of the blue Zo 
button. 

• The  button transfers a cursor-defined region to a re-sizable inset box.  This box 
may be re-sized with the handles located at the upper left and lower right corners.  
The vertical scaling of the inset is independent of the scaling of the main spectrum 
display.  Not available in 2D. 

• The  buttons scale the spectra vertically.  The colour of the 
symbol on the button matches the colour of the spectrum. In 2D mode, these buttons 
control the scaling of any displayed rows or columns.  If you have a "Wheel Mouse" 
you can use the mouse wheel to adjust the vertical scaling of 1D spectra.  If the 
pointer is in the bottom half of the data window, the scale of the experimental 
spectrum will be adjusted.  If the pointer is in the upper half of the screen the scaling 
of the simulated spectrum will be adjusted.  In 2D mode, these buttons adjust the 
scaling of any displayed rows or columns. 

• The  buttons shift the spectra up and down the screen.  In 2D 
mode these arrows select which of any extracted rows or columns is highlighted or 
“active”. 

• The  buttons expand and contract the spectra horizontally.  Usually, it is 
easier to use the cursors and the ZO button, but some routines (e.g. integration) pre-
empt the cursor for their own purposes.  Not available in 2D mode. 

• The   button starts the interactive phasing routine. (1D and 2D) 

• The   button starts the integration routine. (1D and 2D). 

• The   button starts the baseline point routine. Not available in 2D mode. 
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• The  button is used to start a processing dialog that can be a convenient 
alternative to the commands in the Processing menu. (1D and 2D) 

• The  button is used to start a simulation dialog that can be a convenient 
alternative to the commands in the Simulation menu.  The  and  pop-ups help 
prevent “mouse wrist” ☺.  Not available for 2D. 

• The Unit button toggles the axis units between Hz. and PPM. 

• The Cal button calibrates the spectrum.  To calibrate a spectrum: define a point with 
a cursor line, click the Cal button, and then enter the correct value in Hz. or PPM 
(depending on the current axis units).  In 2D mode, you will be asked for the 
calibration in both dimensions. 

•   Display the About box or context sensitive help for SpinWorks. 

Getting Started: Basic 1D NMR Processing 
1.  Setting the Data Format 
SpinWorks needs to know the format of any data before it can be processed.  However, SpinWorks 
2.4 and on can identify the two most common formats (VNMR and XwinNMR/UXNMR) 
automatically.  The current default format is UXNMR, which is appropriate for data from a Bruker 
AMX, ARX, ASX or Avance series spectrometer.  In order to process data form other 
spectrometers, use the Data Format... selection in the Options menu.  The correct format for a 
Bruker AM or AC  spectrometer is DISNMR.  Use the Varian setting for Varian Unity, Unity+ and 
Inova spectrometers.  VXR/S data will probably also work with this setting, but this hasn’t been 
tested.  VXR, Gemini and XL data formats are not supported.  The current data format is displayed 
in the status bar at the bottom of the screen.  The Set Preferences… dialog in the Options menu 
can be used to change the default data format.  JEOL data support is limited to the “JEOL generic” 
format.  Current JEOL spectrometers do not use this format, but can convert their data into this 
format.  TECMAG support is for NTNMR.  Neither the JEOL nor the TECMAG formats have been 
extensively tested. 

1D Data can also be read and saved in JCAMP DX format. 

If there is sufficient interest, I may add support for Bruker WinNMR and Varian Gemini files 

Note that part of the design philosophy of SpinWorks is that it uses the data in the format provided 
by the spectrometer.  Any and all format conversions are internal to the program and are essentially 
transparent to the user.  This also means that the compete data set must be transferred to your PC!  
For UXNMR/XwinNMR data, the entire data tree from the experiment name down should be 
transferred.  This is important, since SpinWorks gets referencing and processing information from 
the proc and procs files, and expects to find them in the same relative place that they were on the 
spectrometer.  For Varian data, SpinWorks expects to find the fid, procpar and text files under the 
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experiment_name.fid directory.  For JEOL data, both the .bin and .hdr files must be present in the 
same directory.  The easiest way to transfer entire directories with contents to your PC is with one of 
the smart ftp programs such as WS_FTP95 or similar.   

2.  Selecting the Data 
Data selection is done with Open... selection in the File menu. You will then be presented with a 
standard Windows file selection menu.  Navigate through directory system and select your data. For 
Bruker AMX and Avance data, navigate from the experiment name directory to the experiment 
number directory and select the file named "fid".  A “recent files” menu is presented at the bottom of 
the File menu and can be used as a shortcut for data selection.  If you have selected a valid data set 
then it will be displayed on the screen after closing the File menu. 

Bug:  If a data set is selected with the program set to the wrong data type (e.g. trying to read 
DISNMR data with the program set to UXNMR/XwinNMR) an error message will be displayed.  
However, you will not be able to select the same data set after changing to the correct data format 
unless you either:   

1. Select a different data set first or  

2. Exit and re-start the program.  Hopefully, this will be fixed shortly. 

Data on CD:  SpinWorks occasionally writes scratch files, processed data or other information, 
usually in the same folder as the experimental data.  This creates a problem for data on CDs where 
you cannot usually (except for CD-RW) write data.  Therefore, data on CD must be transferred to 
the hard disk before processing with SpinWorks.  This also means that you must have write 
permission in the folder where the data are located. 

Annoying MFC “feature”:  The standard MFC library tool used to create the recent files list (File 
menu) has an annoying habit of abbreviating the file path in inappropriate (at least for Bruker and 
Varian  NMR data) places.  This means that you will see that the file selected was “fid” or “ser”, but 
you may not see the folder(s) above it that tell you what the actual data set name was.  One way 
around this problem, is to make sure your data are relatively high up in the folder tree.  For example, 
keeping your data in C:\nmrdata\ will work better better than C:\Documents and Settings\marat\My 
documents… .   Hopefully, I will “roll my own” recent files list for a future release, and this will 
overcome this problem. 

3.  Processing Data 
Data processing involves application of a window function (Exponential Multiplication) followed by 
Fourier transformation.  These two processes are combined in the em+ft selection in the 
Processing menu.  The other selections are for more advanced processing.  The line broadening 
parameter for the exponential multiplication can be set in the Processing Parameters... selection 
of the Edit menu, but a reasonable parameter is set by default.  After processing, a spectrum will be 
displayed on the screen. 

Sometimes, there is a DC bias in the FID which can cause a zero frequency spike in the spectrum.  
This can be removed by checking the FID bias correction in the 1D Processing Parameters… 



dialog.  FID bias correction is not the default for two reasons:  Low frequency signals near the centre 
of the spectrum (usually water) can cause problems with the algorithm; Modern spectrometers have 
very little DC bias in their receivers.  A similar check box exists in the 2D processing parameter 
dialog. 

A pronounced baseline offset in the spectrum can usually be corrected by adjustment of the First 
Point Correction parameter (1D or 2D processing parameter dialogs.).  Typical values will be in the 
0.4 to 0.6 range.  Note that any baseline offset in the spectrum as well as reasonable amounts of 
baseline curvature can also be removed after processing with the baseline correction features in the 
Processing menu. 

Resolution enhancement may be applied by setting the LB parameter to a negative value, with the 
negative of the natural line width being a good starting point.  The GB parameter should be set to the 
relative fraction of the fid where the signal decays into the noise.  For example, it the spectrum has 
peaks with a natural linewidth of 1 Hz., and the fid is gone 1/3 of the way into the acquisition time, 
then set LB to –1.0 and GB to 0.33.  Then process the fid with gm+ft+pk. Some experimentation 
may be required.  If you are re-processing the same data that you have just processed and phased, 
then commands with a +pk appended will phase the data with the last phase constants known to 
SpinWorks.  Note that resolution enhancement may alter the relative integrals of the signals.   

The TRAF window function can provide resolution enhancement with less baseline distortion the 
the GM function.  TRAF uses only the LB parameter, which should be set to something a bit less 
than the natural linewidth.  For routine organic samples in CDCl3, a value of 0.5 to 1.0 Hz seems to 
work well.  A larger value will provide more enhancement but a poorer signal to noise ratio.  For 
most samples, some experimentation will be necessary. 

As an alternative to using the menu bar commands for processing, a processing dialog box can be 
started from the yellow  button on the toolbar.  The minimize (iconize) button can be used to keep 
this panel handy for use at any time. 
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Note that it is not necessary to re-read a data set to reprocess it.  Once a data set has been selected 
once, (e.g. via the File menu) then one can just issue processing commands - the program will 
automatically re-read the raw data from disk each time.   

The Lorentz to Gauss (GM) selection in the processing dialog (or GM in the Processing menu) 
apply resolution enhancement using the LB and GB parameters, identical to that used in Bruker 
software. 

The TRAF function provides resolution enhancement as described by Traficante and Ziessow in J. 
Magn. Reson. 66, 182 (1986).  This function uses the LB parameter to calculate T2.  Optimum 
performance is usually achieved when LB is set to the linewidth of the peaks in the absence of any 
apodization, but some experimentation may be required.  Usually, a smaller value of LB will be 
needed for an acceptable signal to noise ratio. 

The TRAFS function is a modification of the function which optimizes both the resolution and 
signal to noise ratio, as described by Traficante and Nemeth in J. Magn. Reson. 71, 237 (1987). 

The Gaussian selection in the processing panel applies a pure Gaussian window function to the 
time domain data. This function uses the LB parameter (not GB).  In this case, the LB parameter 
specifies the width of 1 σ in the normal distribution, and is slightly closer to the baseline than half-
height. 

HOGWASH resolution enhancement is left for a later section. 

4.  Linear Prediction 
Backward linear prediction is useful for the removal of artifacts (baseline roll) resulting from 
probe ringdown, acoustic ringing, and wideline probe background.  In this procedure the first 
few points of the FID are discarded and replaced with a backward extrapolation of the remaining 
data. Forward linear prediction has very little application in 1D NMR, but is used extensively in 
the indirect dimensions of multi-dimensional NMR experiments.  1D Forward LP is included in 
the 1D routines of SpinWorks for instructional purposes, and for the rare time when the 
acquisition time must be cut short. 

After selecting a data set, the parameters for backward LP may be set in the Edit Processing 
Parameters… dialog of the Edit menu.  The number of points to predict will typically be 4 to 
16, and should be an even number.  The number of coefficients will typically be 16 to 32, while 
the number of input points used for prediction must be greater than or equal to twice the number 
of coefficients.  Generally, the more input points the better. However, specifying too many will 
result in noisy regions of the FID being used in the calculation of the coefficients.  64 Input 
points are suitable for many cases. The linear prediction itself is then performed using the LP 
Process 1D (Backward) selection in the Processing menu.  The FID can then be processed 
normally with any of the usual 1D processing functions in the Processing menu or the pop-up 
Process Dialog.  If the selection of LP parameters was inappropriate make the necessary 
changes, re-apply the LP, and re-process.  Note that backward LP in SpinWorks always uses the 



SVD algorithm. 

For forward LP, the SVD method is generally preferred to the Burg method.  The “reflect roots 
inside unit circle” checkbox applies only to the Burg method, and should generally remain 
unchecked.  The cutoff parameter specifies a significance level for the coefficients.  The default 
value is usually good, but may be raised to speed calculation. †

 

For the use of forward LP in two-dimensional spectra, please see the 2D section of this manual. 

5.  Phasing Data 
After processing, the resulting spectrum must be phased.  The phasing mode is entered by clicking 
on the yellow  button on the toolbar.  A phase dialog box will be displayed and the zero-order 
reference point will be marked with a vertical green line.  Adjust the zero order phase sliders to give 
a properly phased upright peak at the reference mark and adjust the first order sliders to phase the 
peaks that are furthest from the reference line.  Version 2.0 added buttons to adjust ph1 in 180° 
steps.  This should rarely be necessary in 1D spectroscopy, but may be useful in the F1 dimension of 
some 2D experiments.  If necessary, the spectrum may be zoomed or scrolled.  When you are 
satisfied with the phase of the spectrum click on the Apply and Exit button.  Note that you can’t edit 
the values displayed in the ph0 and ph1 boxes – they simply display the values determined by the 
sliders.  If you want to manually enter phase constants, use the Edit Processing Parameters or 
Edit 2D Processing Parameters dialogs (Edit menu). 
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6.  Baseline Correction 
For accurate integration, it will be necessary to apply a baseline correction to the data.  Click the 
yellow   button in the toolbar.  Then use the cursor to define at least 6 baseline points in the 
spectrum. Click the pop-up Return button to exit the baseline points mode.  Then select Automatic 
baseline correction (least squares) in the processing menu.  A third order polynomial correction 
will then be applied to the data.  If necessary, the default correction parameters can be changed in the 
Processing Parameters...  dialog in the Edit menu.  For spectra that have well defined regions 
with peaks and baseline, there is now a fully automatic baseline correction function available in the 
Processing menu. 

The polynomial is defined such that increasing curvature is to the right or low frequency (high field) 
end of the spectrum.  If your data has significant baseline curvature at the left end of the spectrum, 
simply reverse the spectrum, correct the baseline, and then reverse the spectrum to its correct 
orientation. 

7.  Integration 

To integrate the spectrum, select the yellow  button from the toolbar.  A pop-up integration 
dialog box will appear on the screen.  The integration regions can then be selected by using the 
cursor to define the starting and ending points of the integral.  An integral can be deleted by 
selecting it with a single cursor and clicking the Delete Current button in the integration dialog.  
The integration can be calibrated by selecting an integral with the cursor, entering a calibration value 
into the box in the integration dialog (default is 1.0), and clicking on the integration dialog Calibrate 
button.  The integration traces can be scaled up and down independently of the spectrum scaling by 
using the appropriate buttons in the integration dialog.  Clicking Close in the integration dialog will 
remove the dialog and integral traces from the screen, but integration regions are retained until 
cleared with the Delete All button or the program is closed.  Integration regions are retained when 
reading a new data set.  This can be useful when it is necessary to integrate a series of spectra over 
the same region.  If this is not desired simply use the Delete All button of the integration dialog.  In 
SpinWorks 2.2 and up, integration regions are saved in a file with the data on disk, and can be read 
in if you wish to re-process the data with the same integration regions. 

SpinWorks 2.4 and on includes the ability to integrate 2D spectra.  After selecting a region of the 2D 
file to integrate, it is necessary to click the Integrate Area button to add the region to the integrals 
list.  It is also possible to attach a label to the region by filling in the Label field before integrating 
the region.  2D integrals can be calibrated and deleted in the same fashion as 1D integrals. 
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8.  Peak Picking 
Peak frequencies are picked with the Pick Peaks and Append to List selection in the PeakPick 
menu.  The minimum intensity for peak picking is shown with a dashed line across the screen.  The 
height of this line can be set by dragging it with the small box at the left end of the line.  If desired, 
the peak picking minimum intensity can also be set in the Processing Parameters… dialog in the Edit 
menu.  This dialog can also be used to set the noise discrimination threshold for peak picking. Each 
peak pick appends to the current peak list.  This enables one to pick certain regions of the spectrum 
and omit others.  The list may be cleared with the Clear Peak List selection of the PeakPick menu. 
 Specific peaks can be deleted with the Clear Peaks in Region selection. 

A Notepad list of frequencies may be generated with the List selection of the PeakPick menu.  This 
list may then be printed or saved to disk if desired.  The Peak Pick (On Plot) Units selection is 
used to choose between Hz. and PPM (default) for the peak display and print. 

The Interpolation selection is used to set whether the raw cursor frequency is used for the 
calibration and assignment routines or whether an interpolated peak frequency is used.  The default 
is ON. 

The Sign sub-menu can be used to select whether peaks of both positive and negative intensity,  
only positive peaks or only negative peaks should be displayed.  The default is for both intensities to 
be displayed. 

The Calibrate selection is used to reference the spectrum.  Select the reference peak with the cursor 
(a red line will be displayed) and then use the Calibrate selection (or the Cal toolbar button).  A 
dialog will then ask for the calibration frequency.  The value is entered in Hz. or PPM, depending on 
the currently used axis unit. 

9.  Printing 
Spectra are printed essentially as they are seen on the screen.  Integrals will be printed if defined.  
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Peak frequencies will also be printed if peak picking has been done and Peaks and Match in the 
Options menu is turned on (default). Printing defaults to landscape orientation.  In order to change 
to portrait orientation, select Edit Plot Options and Parameters… in the Edit menu and uncheck 
the box labeled Force Landscape Orientation.  The plot orientation can then be set to either 
portrait or landscape via the Print Setup… dialog in the File menu. This selection remains until 
changed or the program is exited.  Select Print Preview... in the File menu to confirm that the 
spectrum will print as desired.  The Print selection or the toolbar Print button is then used to print 
the spectrum. 

The Edit Plot Options and Parameters… selection in the Edit menu can be used to customize the 
plot. 

A plot title may be entered or edited with the Edit Plot Title… selection in the Edit menu.  For 
Uxnmr/XwinNMR data the existing plot title as defined on the spectrometer will be read, and can be 
edited if desired. For VNMR data the first line of the “text” file will be read. 

Note that some printer drivers are broken with respect to the rotated font used for peak frequencies 
and integral values.  The Win 95 drivers for the HP LJ6 seem especially bad (Win NT 4.0 and 
Windows 2000 seem OK).  All print drivers seem to show the peak and integral labels slightly 
displaced in Print Preview although they should be correct on the actual printed page.  The errant 
drivers rotate the peaks the opposite direction in Print Preview and on the printed page, with the 
integral labels overlapping the axis and the peak labels overlapping the label lines.  If you find that 
this is the case, use the Set Preferences… dialog in the Options menu to select Alternate Peak 
Rotation. 

10.  Printing to a MetaFile 
The Copy to MetaFile… command in the Edit menu can be used to produce a copy of the spectrum 
as it is set up to print as a Windows Enhanced MetaFile (*.emf).  This file can then be imported into 
Word (e.g. with Insert: Picture: From File) , PowerPoint, etc.   This command opens up a file save 
dialog, allowing you to save the file to any desired folder.  The .emf extension will be automatically 
added to the file name.  The various objects to be included in the metafile can be set with the Edit 
Plot Options… selection in the Edit menu.   One possible problem is that the scaling of the 
SpinWorks graphics are often too big for a PowerPoint document (due to the difference in units used 
by the different programs).  The solution is (in PowerPoint) to reduce the zoom factor (the list box 
on the toolbar with things like “75%” on it) to about 25 %.  Then use the resize handles on the 
imported SpinWorks graphics to size the spectra appropriate to the document. The zoom factor can 
them be restored to whatever value you normally use. 

You can also copy SpinWorks spectra to programs like Word and PowerPoint with the Windows 
Clipboard.  The Paste Special... function seems to work best, allowing the Spectrum to Float 
over Text.  This method seems to incorporate spectra at the correct size, at least for Word.  

Metafiles are created with a resolution that is greater than screen resolution (the default is 2 times 
screen resolution) but with less resolution than that on printed spectra.  To increase the resolution of 
metafiles you can use the MetaFile Resolution parameter in the Plot Options and Parameters… 
dialog (Edit menu).  Using higher resolution will use more disk space for the metafiles and any 



documents that incorporate them. 
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Figure 1  Student spectrum with poor shim imported into Word 

 
11.  JEOL Data 
Support for JEOL data is currently limited to 1D data in the so-called “JEOL Generic” format.  
This format can be identified as two files, one with a .bin extension (the data) and another with a 
.hdr extension (the parameters).   

Recent JEOL spectrometers seem to be using digital filters similar to those used by Bruker.  That 
is, there is no compensation for filter group delay.  This data is characterized by a “build-up” 
period at the beginning of the FID and spectra with extreme first order phase requirements.   
There are two ways to process this data: 

1. In the interactive phasing mode click the ph1: +180 button repeatedly and take note of the 
oscillation in the baseline and the phase of the peaks.  You should see the frequency of the 
oscillation decrease, and at some point the baseline will be flat and the peaks should all have 
nearly the same phase.  Then adjust the zero and first order phases until the spectrum is 
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phased properly. 

2. The FID can also be left-shifted to compensate for the filter delay.  The left shift can be set in 
the 1D processing parameter dialog.  With the sample data that I have, a 20 point left shift 
was optimum. 

Note that the two methods do not produce identical results, although both methods are 
acceptable.  For Bruker Avance data, SpinWorks understands the characteristics of the digital 
filters and applies the necessary phase shift (as in method 1 above) automatically at the time of 
transform.   SpinWorks does not left shift Avance data, unless you want a left shift for some 
other reason. 

Shown below are JEOL data processed with no correction, correction by phasing and correction 
by left shifting. 
 
SpinWorks 2.5:  JEOL DSP   Top: raw;   Middle: phased;   Bottom: 20 pt left shift

PPM   10.0     9.0     8.0     7.0     6.0     5.0     4.0     3.0     2.0     1.0    0.0    -1.0   

file: C:\data\marat\nmr\Trp_generic.bin   expt: 
transmitter freq.: 399.782198 MHz
time domain size: 65536 points
width:  5000.00 Hz = 12.506810 ppm = 0.076294 Hz/pt
number of scans: 0

freq. of 0 ppm: 399.780199 MHz
processed size: 65536 complex points
LB:    0.300    GB: 0.0000

 

2D Processing 
Introduction to 2D Processing 
SpinWorks now (version 2.0 and on) has the capability to process 2D data sets from UNIX and 
NT based Bruker (A?X and Avance) and UNIX based Varian (Inova, Unity, Mercury, Gemini) 
spectrometers.  Provision has been made for Hypercomplex (States, States-TPPI, echo-antiecho), 
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TPPI and Magnitude mode data. Echo-antiecho Varian data did not work properly prior to 
version 2.0 PL6. 

Every attempt has been made to make the 2D mode of SpinWorks as consistent as possible with 
the 1D mode.  SpinWorks also tries to set processing parameters and modes that are appropriate 
for the data, resulting in very easy processing.  However, inappropriate parameters (e.g. 
referencing, detection mode, etc.) may be inherited from the original data.  In these rare cases, 
the parameters can be overwritten in SpinWorks. 

Selecting the 2D Data Set 
SpinWorks 2.4 should automatically detect Varian and Bruker data formats, and can distinguish 
between 1D and 2D data.  However, should this not work for some reason, you can use the 
Options menu set the Data Format according to the brand of spectrometer that you are using 
(Bruker or Varian) and also set the 2D selection. The default data format can be changed in the 
Options menu.  In the File menu use the Open… command or the recent files list to select the 
appropriate raw spectral data.  Select the ser file for Bruker data and the fid file for Varian data.  
If you use the Open command, you will have to navigate through the directory tree to the correct 
file.  Bruker data sets have the structure: …/exname/ex#/ser  while  Varian data sets have the 
structure: …/exname.fid/fid.  When you are transferring data make sure that you transfer the 
entire data set, as SpinWorks requires information from the various parameter sets that are stored 
with the raw fid data (the procpar, acqus procs, proc, title, etc. files).   

You can use the Set Preferences selection in the Options menu to set the default data 
directory for the File Open… dialog. 

After the data set has been opened, the first FID (first t1 value) will be displayed on the screen. 

Setting the 2D Processing Parameters 
SpinWorks tries to get most of the necessary processing parameters from the parameter files of 
the data set.  If you want to override these, or to simply check on the parameters, you can use the 
2D Processing Parameters… selection in the Edit menu.  Separate panes are available for the 
detection (F1) dimension and the evolution (F2) dimension.  The following parameters can be 
edited: 

• Size   The number of complex data points in each dimension.  This value must be a power of 
2, and will be rounded up to the nearest power of 2 if it isn’t. 

• Frequency of 0 ppm   This is the value (in MHz) used as the calibration reference point in 
the spectrum.  If the data were properly calibrated on the spectrometer, then this value should 
not need to be changed.  Referencing can also be accomplished (more conveniently) with the 
Cal button on the toolbar. 

• Detection Mode   (F1 only)  Specifies whether the data were recorded in single (magnitude 
or Bruker QF mode) TPPI, States, States-TPPI or echo-antiecho, mode.  SpinWorks can 
normally determine this from the data set parameters.  The sequential setting is not currently 
used.  Note that the Varian gHSQC sequence uses echo-antiecho, and sequences that the 
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Varian documentation specifies as States-TPPI, processes in SpinWorks as States.  The 
necessary correction to convert the data to States format has been applied at the 
spectrometer.  For Varian data, the F1 detection mode is determined from the “f1coef” and 
“phase” parameters. 

• Reverse   (F1 only)  Check this box if you find that the F1 direction needs to be reversed.  
This is pulse sequence and spectrometer model dependent.  SpinWorks should set this 
correctly for most data sets.  An exception seems to be magnitude mode data (e.g. COSY and 
HMBC) from Bruker AMX spectrometers.  Data from Avance series spectrometers should be 
O.K.  Using the F3 (a.k.a. Y or decoupler B) channel for HSQC type experiments on an 
AMX spectrometer may also result in a reversed F1 dimension. 

• First Point Correction   Applies a multiplier to the first point of the FID.  The default value 
of 0.5 is good for the vast majority of data sets.  Experiment with the value if you need to 
remove some baseline offset in the transformed spectra.  An alternative is to apply drift 
correction (2D Processing sub-menu) after processing. 

• Bias Corr.   Determines whether a DC offset or bias correction should be applied to the FID. 
 The default value is OFF, and it should only be turned on if there is a noticeable zero 
frequency “spike” at the centre of the spectrum. 

• Window Function   This is the pre-transform apodization function applied to the data.  
Choices are: none, Lorentz,  Lorentz to Gauss (the Bruker “GM” function), Sine, Sine 
Squared, TRAF, TRAFS and Gaussian.  Details of the TRAF and TRAFS functions can be 
found in the 1D processing section.  The shift parameter is the shift (in degrees) for the Sine 
and Sine squared function, while the LB and GB parameters are used by the Lorenz, Lorentz 
to Gauss, TRAF, TRAFS and Gaussian functions.  Note that the Lorentz to Gauss selection 
uses the LB and GB parameters, while the Gaussian Selection uses LB only. 

For Bruker data, the window function and parameters specified on the spectrometer will be 
used. For Varian data, SpinWorks currently selects window function parameters based on the 
detection mode and pulse sequence name (if a standard Varian pulse sequence was used).  
The reason for this is that the window function definition and parameters used in SpinWorks 
differ somewhat than those used by VNMR.  Future versions will hopefully select the 
window function and parameters based on the values set in the spectral parameters. 

• Linear Prediction   Specifies the parameters used for linear prediction of the data set.  This 
is typically used in F1 only, when the number of time domain data points is small.  You can 
specify the number of points to be predicted, the number of coefficients (Maximum entropy 
poles), the number of input points used for prediction, and whether you want forward or 
reverse prediction. In version 2.4, only forward prediction is supported in F1, while only 
backwards prediction is supported in F2.  These parameters may require some 
experimentation, but the default values are usually satisfactory.  Typically, you can usually 
double the number of time domain data points in F1, and the number of coefficients will 
typically be 8 to 16.  The number of Input Points can usually be set to the one half the 
number of time domain points in T1, which is the default value. If you get what appears to be 
streaking in F1, you can increase the number of input points and/or the number of 
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coefficients.  The Cutoff value can be left at the default value for most cases, but raising it 
can speed up the LP procedure. 

The newest LP addition is the Zhu-Bax “forward-backward” algorithm (J. Magn. Reson. 100, 
202 (1992)).  Although not yet fully tested, this routine seems better than the others, and can 
extrapolate the data further than the others.  For example, extrapolation from 128 to 512 
points is possible for data with a good signal to noise ratio.  It is not recommended to raise 
the number of coefficients above 16, and the input points parameter is not used for this 
algorithm (the whole data set is used).  Future releases of SpinWorks may have this as the 
standard or default LP algorithm. 

There is also an alternate forward LP routine that can be used by setting the LP type to 
Forward (old).  This routine can sometimes provide better resolution than the "standard" 
forward LP routine, but it also has a tendency to "blow up" on noisy data.  There are two 
algorithms that can be used for linear prediction. The first is the singular value 
decomposition (SVD) method, and the second is the Burg or maximum entropy (MEM) 
method.  SVD almost always works better, but you can experiment to see which works best 
for your data. The Burg and SVD settings apply only to the “old” LP algorithm. 

Note: In most cases simply selecting Forward or Zhu-Bax and leaving all of the other 
parameters at their default values will provide the best results. 

Note:  Linear prediction works well when the indirect dimension has been abbreviated in 
order to save experiment time.  Applying linear prediction to a data set that has already 
decayed to the noise will not provide any improvement in resolution, and will likely result in 
poorer sensitivity.  

For F2 (the detection dimension) it is always better to increase the resolution by increasing 
the acquisition time (narrowing SW or increasing TD) rather than by relying on linear 
prediction.  This does not increase the experiment time, as the increase in acquisition time 
can be compensated by a reduction in the relaxation delay.  

Ignore the  Move Roots Into Unit Circle checkbox. 

• Phasing   Specifies the type of phase correction to be applied to the data during the 
transform.  Possible values are: none (you will phase the data interactively later) constants 
(the specified zero and first order corrections will be applied to the data during transform), 
magnitude (appropriate for the F1 dimension for magnitude COSY and HMBC) and power. 
 Note that applying magnitude or power spectrum processing to the detection dimension (F2) 
would be pretty silly. 

• HOGWASH (F1 only) parameters.  These are described separately in the HOGWASH 
section of this manual. 

• Solvent Filter   (F2 only) This provides a high-pass filter for removing a strong solvent 
signal (e.g. H2O) from the centre of the spectrum.  Gauss or Sine usually work best, and the 
number of points determines the selectivity of the filter.  A larger number of points creates a 
narrower filter, with the default value giving good results for typical proton 2D spectra 
recorded in water.  However, you should experiment to achieve the best result. 



• F1 Ref Freq   (F1 only)  Specifies the frequency to be used for Hz to ppm conversion in the 
F1 dimension.  Buttons are available for the Observe transmitter, Decoupler or Decoupler 2.  
The frequency can also be entered manually.  These buttons are most often used to correct 
bad “refsource1” or “refsource2” parameters in Varian data sets. 

 

 

 

 
 

F2 processing parameters 
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F1 processing parameters 

 

Processing 2D Data 
Transform  
Once you have selected your 2D data and have set the processing parameters, you will need to 
process it.  In 2D mode the yellow Proc button on the toolbar will start the “stay-up” 2D 
processing and display dialog box.  This box can be minimized at any time if desired.  Although 
you can process the F2 and F1 dimensions separately, it is usually easiest to click in the Both 
button to do a complete transform of the data.  For 2D data sets that do not require phasing (e.g. 
COSY, HMBC and HETCOR), clicking the Both button may be the only processing that the 
data set requires.  This will be true if appropriate window functions and other processing 
parameters were set up correctly at the time of acquisition.  (For experiments run with 
ICONNMR or with the standard parameter sets, this will always be so.) 
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2D MQ MAS spectra require a special type of transform called a “shearing transform,” in which 
a T1 dependent first order phase correction is applied to each row of the spectrum after the first 
(T2) transform.  The phase constant or “shearing angle” depends on the spin of the nucleus and 
the quantum selection of the experiment.  The angle can be calculated with the MQ MAS 
Toolbox… dialog available in the 2D Processing sub-menu of the Processing menu.  A 
particular angle can also be entered, if desired. 

 

The referencing buttons adjust the referencing so that each of the dimensions can be referenced 
to the transmitter, if desired. 

The shearing transform for MQMAS data has only been tested on Varian data.  Testing with 
Bruker data is still required. 

Note that the scaling of the F1 axis retains the scaling of the original unsheared data.  There are 
several conventions for the scaling and referencing of MQMAS data, and there does not seem to 
be a consensus as to which one is best.  Consult: 

Y. Millot and P. P. Man, Solid State Nuclear Magnetic Resonance, 21 21-43 (2002) 

and other solid state NMR literature for a detailed discussion. 

Some other less frequently used 2D processing commands are also found in the 2D Processing 
sub menu of the Processing menu. 

2D Display 
The default mode for the 2D display is “image” mode where both the positive and negative 
intensities will be displayed.  For magnitude data and phased phase sensitive data, a pos only 
mode can be selected in the 2D Processing and Display dialog.  It is also possible to display 
the data in a “contour” mode and to select coarse or fine contour spacing.  The lowest displayed 
contour and the highest displayed contour can be adjusted with the floor and range buttons.  
Note that  -   means moving the floor level down, or closer to the noise.  Therefore click the  -  
button to see smaller peaks.  Similarly, moving the range up or down will control the number of 
levels displayed.  As a starting point, set the floor just above the noise (or artifact) level and 
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adjust the range so that the highest peaks are displayed in the most intense colours.  For spectra 
with very large dynamic range, lowering the range even further will give more contours on the 
smaller peaks at the expense of the more intense peaks. 

In image mode, all levels below the “floor” will be black, while all levels above the range or 
ceiling will be displayed in the color of the highest level. 

The “image” display mode is considerably faster than the contour mode.  Printing is always done 
in contour mode irrespective of the display setting. 

 

 
Clicking the left mouse button with the cursor in the data area will cause a set of red cross-hair 
lines to be drawn.  Clicking again will cause a second set of lines to be drawn and will thus 
define a region.  This region can be zoomed by clicking the middle mouse button (if available) or 
the blue Zo button on the toolbar.  The cross-hair lines can be erased by clicking the left mouse 
button a third time or with the blue Clr button on the toolbar. 

Individual rows or columns of the 2D matrix can be selected and displayed with clicks of the 
right mouse button.  The selection of row mode or column mode in the 2D Processing and 
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Display dialog box determines which will be displayed.  Switching to 1D display mode will 
transfer the last highlighted row to the 1D display.  You can examine and plot individual 2D 
rows in this manner, using all of the 1D tools of SpinWorks.  You can select which of the rows is 
highlighted (in yellow) by selecting it with the toolbar up and down arrows. Currently (version 
2.4), columns cannot be transferred to the 1D display mode.  However, columns can be saved as 
JCAMP-DX files (see below), and then read as 1D spectra. 

Rows or columns selected with the right mouse button can be saved as JCAMP_DX files by 
using the Save Displayed Columns or Save Displayed Rows selections in the File menu.  
These spectra will be saved with names like row482.dx in the folder containing the folder 
containing the current raw data.  The titles in these files will have the chemical shift of the 
extracted row or column attached.  These rows and columns can then be read by SpinWorks in 
1D mode, but be sure to set the data type to JCAMP-DX first. 

When extracted rows or columns are displayed on the screen, one will be highlighted in yellow, 
while the others will be displayed in blue-green.  The highlighted trace is one to which vertical 
amplitude scaling will be applied (toolbar + and – buttons).  The currently active trace can be 
changed with the toolbar up and down arrows. 

Hint: If you have sufficient memory in your computer, you can start a second (or third) copy of 
SpinWorks for examination and printing of the extracted rows and columns.  This allows you to 
keep the 2D data in the first copy. 

A cross-hairs cursor can be displayed on the screen by using the tracking cursor selection in the 
Options menu.  You can use the keyboard “t” key as a shortcut to toggle the cross-hairs on or 
off.  “Double clicking” will also toggle the cross-hair cursor.  Occasionally, if the cross-hairs 
have been overlapped by a pop-up dialog, there will be stray pieces of cross-hairs left on the 
screen when the dialog is moved or closed.  You can clear these cursors by refreshing the screen 
with the keyboard “r” key.  As of version 2.3 and up, this problem should be fixed. 

Spectra can be displayed and printed with the F1 axis horizontal by using the Rotate 2D 
selection in the View menu.  Note that interactive phasing requires that F2 axis be horizontal.  
Spectra can be rotated to the desired format after phasing, of course. 

Phasing 
The 2D data may be phased in several ways: 

• Phase constants set in the 2D Processing Parameters dialog (Edit menu) can be applied at 
the time of transform.  It the data have been previously phased with XwinNMR or VNMR, 
the phase constants read in with the data should work in SpinWorks. 

• Phase constants set in the 2D Processing Parameters dialog (Edit menu) can be applied 
after the transform.  This is accomplished with the F2 (det.) F1 (evol.) or Magnitude 
buttons in the Phasing section of the 2D Processing dialog. 

• The first increment fid can be transformed and phased to give the F2 (acquisition dimension) 
phase constants.  Note that this method will not work for experiments that have zero intensity 
in the first increment.  For example, some phase sensitive COSY experiments. 



• The 2D spectra can also be phased interactively.  The method is essentially the same as used 
in 1D mode.  Note that the spectra must be in the normal (to me) “F2 horizontal” mode for 
interactive phasing.  Use the View menu to turn the Rotate 2D option off if necessary.  
Spectra can be rotated to the “F1 horizontal” mode after phasing, if desired. 

• Select either the row mode or column mode in the 2D Processing and Display dialog 
(use the yellow  toolbar button if this dialog is not already active). 

• Select rows or columns that contain peaks in diverse regions of the spectrum by clicking 
on the peak with the right mouse button.  The extracted row will be displayed on the 
screen.  The amplitude of the extracted traces can be changed with the + or – buttons on 
the toolbar.  The highlighted trace only will be changed.  Which trace is highlighted can 
be changed with the toolbar up and down arrows. 

• Select the peak to be used as the pivot point (the point where the first order phase is 
always zero) by marking it with the left mouse button. 

• Use the phase button on the toolbar to start the interactive phasing routine.  Adjust the 
zero order phase (ph0) on the selected pivot peak (it should be marked with a green line) 
and adjust the first order phase (ph1) on the other peaks.  Note that in column mode, 
positive is to the right.  When satisfied with the phase, click on the Apply and Exit 
button. 

• Now phase the other dimension, if required.   

Note that most Varian pulse sequences are written so that the F1 phase correction is zero (or very 
close to zero).  In such cases no F1 phase correction is usually required. However, due to 
differences in processing algorithms, some (usually echo-antiecho) data that have zero F1 phase 
correction in VNMR may require exactly a 90 degree correction in SpinWorks.  SpinWorks can 
recognize some of these sequences and set the phasing constant appropriately.   

Many Bruker experiments calculate the F1 phasing based on the delays and pulse lengths in the 
sequence.  These phase constants will work in SpinWorks with the F1 phasing set to constants.  

Baseline Correction 

2D spectra in organic solvents rarely require baseline correction.  However, if baseline 
correction is required, it can be applied to either dimension with the Baseline Correct F2 or 
Baseline Correct F1 selections of the 2D Processing sub-menu of the Processing menu.  A 
third order polynomial is normally used, but this can be increased with the Edit Processing 
Parameters dialog.   

If the baseline is offset or sloped, but not very curved, It is probably better to use “drift 
correction” instead of baseline correction.  This corrects any slope and bias in the baseline, and 
will be familiar to VNMR users.  The drift correction commands are also in the 2D Processing 
sub-menu of the Processing menu.  

Note that the first point correction value (2D Processing Parameters dialog) will also affect 
the dc offset of the spectrum. 
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F2 and F1 Reference Spectra 

Processed 1D reference spectra can be displayed and printed along the F2 and F1 dimensions. 

• Process the 1D data normally and save the processed spectra as JCAMP-DX files  (File 
menu). 

• After processing your 2D data, use the Read buttons in the 1D Traces group box of the  2D 
Processing and Display panel to Read in the JCAMP-DX files as "projections." 

• The vertical scaling can be adjusted with the + and - buttons, and the individual traces can be 
turned on or off with the appropriate check box.  The F1 and F2 reference spectra can also be 
scaled by placing the cursor near the appropriate 1D spectrum and using the mouse wheel (if 
you have one). 

• Note that the 1D reference spectra do not have to have been recorded with the same SW as 
the 2D spectrum.  They do, however, have to be recorded at the same field. 

Projections 

• As an alternative to displaying external 1D spectra along the edges of a 2D spectrum, it is 
also possible to display projections of the 2D data.  This can be very useful for a dimension 
where a 1D reference spectrum cannot be recorded.  An example would be the 13C dimension 
of HSQC, HMQC and HMBC type experiments.  For these experiments, data can often be 
obtained for samples that are too dilute for conventional 13C spectroscopy.  The projections 
can be generated by the Proj. buttons on the 2D Processing and Display dialog.  The 
projections can be scaled by placing the cursor near the appropriate 1D spectrum and using 
the mouse wheel (if you have one), or by the + and – buttons in the dialog box. 

When the projections are generated, copies are also saved in the current data folder as 
JCAMP-DX files.  These have the names f1_proj.dx and f2_proj.dx, and can be read by 
SpinWorks in 1D (JCAMP-DX) mode.  They can then be peak picked, printed, etc. just as 
normal 1D spectra. 

F2 and F1 Traces (Scanning) 

Interactive scanning of F2 and F1 traces can be displayed by clicking the F2 Scan and/or the F1 
Scan check boxes.  The cross-hair cursor will also be turned on, in order to make it easier to see 
where the trace is being extracted. 

F1 Referencing 

In a perfect world, spectrometer manufacturers would provide parameter sets for all of the 
common 2D sequences with correct referencing information in F1.  Failing this, the facility staff 
should set up the referencing information.  Alas, the real world seems to be quite different.  
Bruker data recorded with standard parameter sets, especially if recorded with ICONNMR, seem 
to be reasonably good.  Varian data sets seem to be much poorer, especially for indirectly 
detected heteronuclear correlation experiments (HSQC, HMBC, etc.)  Homegrown parameter 
sets may or may not have correct referencing information.  

A problem that often occurs with Varian data is an incorrect “refsource1” parameter.  This 
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specifies the channel that is used for Hz to ppm conversion in evolution dimension.  For 
experiments like HSQC, gHSQC, gHMBC, etc. this parameter needs to be set to “dfrq”, but 
quite often is set to “sfrq”.  Likewise, some BioPack sequences such as gNhmqc have 
“refsource1” set to “sfrq” whereas in this case is should usually be “dfrq2”.  To correct problems 
with F1 channel selection, the F1(evolution) panel of  2D Processing Parameters dialog has 
buttons to set the channel used for Hz to ppm conversion in F1.  In the Special Cases group 
box, there are buttons to set the F1 channel to the observer transmitter, the decoupler or the 
second decoupler.  The frequency can also be entered manually into the edit box, but this should 
rarely, if ever, be required. 

Once it is certain that F1 is using the correct frequency for Hz to ppm calculations, it may be 
necessary to set the actual reference position.  With properly edited parameter sets (on the 
spectrometer end) this value is usually pretty good, but is rarely perfect due to differences in 
concentration, temperature, solvent, etc.  There are several ways that calibration of the indirect 
(F1) dimension can be accomplished: 

1. If the shift of a peak is known (usually from a 1D spectrum) then the calibrate button 
(toolbar) can be used to set a peak to a known shift value.  Simply select the desired peak 
with the cursor, click the toolbar calibrate button and then enter the correct shifts in the 
dialog box. 

2. If the absolute frequency of 0 ppm is known, it can be entered into the appropriate box in the 
F1 page of the 2D Processing Parameters dialog.  This value can usually be seen on 1D 
plots produced by SpinWorks or XwinNMR (SF parameter).  If this value is not available for 
your particular sample, (often because you haven’t run a carbon spectrum) then the value 
from another sample in the same solvent at the same temperature will be very close. 

3. An automatic referencing of F1 for many experiments can be accomplished using the Auto 
Reference F1 sub menu in the Processing menu. Select the F1 nucleus and solvent 
appropriate to your data.  This procedure assumes that the F2 dimension is proton, and has 
been correctly referenced.  The reference values used are valid for dilute solutions at 25°C.  
The homonuclear option will set the referencing in F1 to be the same as that in F2. 

Note that even if the referencing in the 2D spectrum is identical to that in the 1D spectrum, there 
may not be perfect alignment between the two in some experiments.  There are two reasons for 
this.  In the F2 dimension of an HSQC or HMBC type experiment (or F1 of a HETCOR or 
COLOC experiment), the observed signals are due to the 13C isotopomer, while what is observed 
in the 1D proton experiment is the 12C isotopomer.  There is an isotope shift between the two, 
which becomes more noticeable at higher fields.  The second reason for a misregistration of 
peaks between 1D and 2D experiments is due to the sample heating which may occur from X 
nucleus decoupling.  This effect is most noticeable in solvents where the lock shift is temperature 
dependent, usually D2O.  Adequate cooling air and newer low power (adiabatic) decoupling 
sequences can reduce this effect. 

Remember, though, that with decent parameter sets on the spectrometer, manual adjustment of 
the F1 referencing should only be required in special circumstances.  E.g. different temperature 
or pH, odd solvent, etc. 



2D Integration 
2D Spectra can be integrated with the same dialog used for 1D integration.  The method used to 
define the integrals, though, is slightly different.  After defining a region to be integrated with 
two cross-hair cursors, it is necessary to click on the Integrate Area button to generate the 
integral.  You can also define a label for the integral by entering text into the Label box before 
clicking the integrate button. 

 

2D Processing Tutorial 
A number of 2D data sets are available for download, and contain data acquired on both Varian 
and Bruker spectrometers, with a number of detection modes. 

Magnitude (COSY type) Data 
These data sets are usually processed with unshifted sine window functions in F1 and F2, 
magnitude phase correction in F1 (only!) and "single" type detection mode.  With SpinWorks 2.4 
and up, it should not be necessary to specify whether the data are Varian or Bruker, as the 
program can identify the data format automatically.  It should also automatically determine 
whether the data are 1D or 2D.  A confirmation question will be asked for Varian data before 
switching to 2D mode. 

1. Use the File Open command to navigate through the supplied sample data and select either 
the  …gCOSY.fid/fid  Varian file or the  …cosy_qf/3/ser  Bruker file.  After selecting the 
file, the first block (fid) of the 2D data set will be displayed.  If these data sets are not 
available, any Bruker or Varian COSY or gCOSY type data set could be used. 

2. Use the Edit 2D Processing Parameters… selection in the Edit menu to examine the 2D 
processing parameters.  With the supplied sample data, these will all be correct, and are 
typical of what would be used for a magnitude COSY spectrum. Note that for Bruker data the 
processing parameters are read from the data set.  If the data set was set up correctly on the 
spectrometer, it should process on SpinWorks without any adjustment of the processing 
parameters.  For Varian data, the default processing parameters are based on the name of the 
pulse sequence, the “f1coef” parameter and the “phase” parameter.  If SpinWorks recognizes 
the pulse sequence, it should default to reasonable parameters.  If SpinWorks doesn't 
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recognize the pulse sequence, then you may have to set the processing parameters yourself.  
Note that the COSY type parameters are also suitable for HMBC spectra, however the 
window functions should be changed to sine or sine squared with a 45 to 90 degree shift. 

3. Close the processing parameter dialog and start the 2D Processing and Display dialog by 
clicking the yellow   button on the toolbar. Click the Both button in the Processing 
group.  The status of the transform will be displayed at the bottom of the screen, and when 
finished an image mode 2D spectrum will be displayed on the screen.  This can be changed 
to contour mode by selecting the contour radio button.  Note that the current contouring 
algorithm in SpinWorks can be a bit slow on some machines.  Since this is magnitude mode 
data, mapping negative levels doesn't make any sense.  Therefore, select the positive only 
radio button to display the positive contours in a more complete set of colours.  The floor 
(lowest contour) and range (highest contour) can be changed with the appropriate buttons. 

4. Clicking the left mouse button in the data window will mark the point with a set of red cross-
hair cursors.  Clicking the left mouse button in the data window a second time will define a 
region that can be zoomed with the blue Zo button on the toolbar or by clicking the middle 
mouse button.  Clicking the left mouse button in the data window a third time will erase the 
cursors. 

5. Use the Edit 2D Processing Parameters… selection in the Edit menu to set F1 linear 
prediction to Zhu-Bax, the number of coefficients to 16 and the number of predicted points 
to 512.  Exit the dialog by clicking the O.K. button.  In the 2D Processing and Display 
dialog, click the Both button to re-process the data.  You should see a significant 
improvement in the resolution in the F1 dimension. 

6. Print and Print Preview in the File menu work as expected. 

7. If you wish to apply baseline correction or symmetrize the data, these functions are available 
in the Processing menu. 
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SpinWorks 2.3:  Strychnine, COSY 45, Avance300, Zhu-Bax LP
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file: C:\data\marat\nmr\strychnine\2\ser   expt: <cosy45gs>
transmitter freq.: 300.131411 MHz
time domain size: 2048  by  256 points
width:  2380.95 Hz = 7.933033 ppm = 1.162574 Hz/pt
number of scans: 2

F2: freq. of 0 ppm: 300.130006 MHz
processed size: 2048 complex points
window function: Sine
shift:   0.0 degrees

F1: freq. of 0 ppm: 300.130006 MHz
processed size: 2048 complex points
window function: Sine
shift:   0.0 degrees

 
Figure 2 Magnitude gCOSY45 spectrum of strychnine recorded on an Avance 300.  Zhu-Bax linear prediction has 
been applied in F1, but the data have not been symmetrized. 

 

Phase Sensitive (HSQC type) Spectra 
There are several ways in which phase sensitive data can be recorded.  The data can be purely 
hypercomplex (two FIDs recorded 90° out of phase, but with the same t1 value - often known as 
the States method), TPPI (t1 and phase incremented at the same time), a hybrid called States-
TPPI, or the echo-antiecho method, which applies to certain types of gradient experiments.  
SpinWorks must know how the data were recorded in order to process it correctly.   

For Bruker data, this information is obtained from the processing parameters in the data set. Data 
recorded with standard Bruker parameter sets (e.g. in IconNMR) will almost always have correct 
processing parameters.   Parameter sets created by users may, however, be incorrect.  Most phase 
sensitive Bruker pulse sequences use TPPI, although we commonly use an echo-antiecho HSQC. 
The comments included with each Bruker pulse sequence usually indicate the detection mode 
used. 

Note that the F1 phasing can be calculated, and does not change unless you change the F1 
spectral width. On the supplied Bruker data, the F1 phase constants  (as calculated by XwinNMR 
or set up in the parameter set) should do a good job of phasing F1 if you tell SpinWorks to apply 
phasing during the transform. (Edit 2D Processing Parameters… →  F1 (evolution) →  
Phasing  → Constants).   
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It is also possible to adjust the timings in a pulse sequence so that there is no required F1 phase 
correction.  This approach is seen in most Varian data. 

For Varian data, SpinWorks guesses the F1 detection mode from the name of the pulse sequence. 
If the pulse sequence name is not recognized by SpinWorks, SpinWorks then uses the “f1coef” 
and “phase” parameters. If the “f1coef” parameter is null or not recognized, SpinWorks will 
assume either COSY type or States type data, depending on the “phase” parameter. Most phase 
sensitive Varian pulse sequences are either hypercomplex (States) detection (e.g. HSQC, 
TOCSY, NOESY) or echo-antiecho (e.g. gHSQC).  Some sequences in BioPack or ProteinPack 
are written as States-TPPI, but the data seem to be converted to pure hypercomplex (States) 
when the data are stored to disk.  These data sets can be processed exactly like States data.   

Selection of Varian vs. Bruker and 1D vs. 2D should be automatic. 

1. Use the File Open command to navigate through the supplied sample data and select either 
the  …HSQC.fid/fid  Varian file or the  …hsqc_av300/2/ser  Bruker file.  After selecting the 
file, the first block (fid) of the 2D data set will be displayed.  If these data sets are not 
available, any Bruker or Varian HSQC, gHSQC or HMQC type data set should work. 

2. Use the Edit 2D Processing Parameters… selection in the Edit menu to examine the 2D 
processing parameters.  With the supplied sample data, these will all be correct, and are 
typical of what would be used for an HSQC spectrum. Note that for Bruker data, the 
processing parameters are read from the data set.  If the data set was set up correctly on the 
spectrometer, it should process on SpinWorks without any adjustment of the processing 
parameters.  For Varian data, the default processing parameters are based on the name of the 
pulse sequence.  If SpinWorks recognizes the pulse sequence name, it should default to 
reasonable parameters.  If SpinWorks doesn't recognize the pulse sequence, then you will 
have to set the processing parameters yourself.  With some data sets, it may be necessary to 
optimize the Windowing parameters for optimum signal to noise ratio. 

3. Close the Edit 2D Processing Parameters… dialog and click the toolbar Proc button to 
start the 2D Processing and Display dialog.  Click the Both button in the Processing 
group to process the data. 

4. After the processing is finished and the spectrum is displayed, select rows containing peaks 
with the right mouse button.  Usually, two or three rows are sufficient, if they contain peaks 
near both ends of the spectrum.  The vertical scaling of the displayed 1D traces can be 
adjusted with the black + and – buttons on the toolbar. 

5. Use the left mouse button to select a peak to be used as the pivot point. 

6. Click the toolbar Phase button: .  Adjust the phase of 1D traces. When satisfied, click on 
the Apply and Exit button.  The 2D spectrum with the applied F2 phase correction will now 
be displayed. 

7. In the 2D Processing and Display dialog, switch to Col Mode in the Rows/Columns group 
and do any required F1 phase correction. 

8. Use the Clear button in the Rows/Columns group to remove any displayed rows or columns 
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and print any desired regions of the spectrum. 
8. Use the Edit 2D Processing Parameters… selection in the Edit menu to set F1 linear 

prediction to forward, the number of coefficients to 16 and the number of predicted points to 
256.  Leave the algorithm set to SVD.  Exit the dialog by clicking the O.K. button.  In the 2D 
Processing and Display dialog, click the Both button to re-process the data.  You should 
see a significant improvement in the resolution in the F1 dimension. 

9. Print the spectrum, if desired. 
SpinWorks 2.0:  strychnine
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file: C:\data\marat\nmr\Varian_2D\HSQC.fid\fid   expt: "HSQC"
transmitter freq.: 400.113938 MHz
time domain size: 2048  by  256 points
width:  6387.74 Hz = 15.964791 ppm = 3.119011 Hz/pt
number of scans: 4

F2: freq. of 0 ppm: 400.111537 MHz
processed size: 2048 complex points
window function: Sine Squared
shift:  90.0 degrees

F1: freq. of 0 ppm: 100.608102 MHz
processed size: 2048 complex points
window function: Sine Squared
shift:  90.0 degrees

 
Figure 3 HSQC spectrum of Strychnine recorded on an Inova 400.  SVD linear prediction has been applied in F1. 

Simulation Tutorial 

SpinWorks uses the NUMARIT algorithm as described in: J. S. Martin and A. R. Quirt, J. Magn. 
Reson. 5, 318 (1971), and modified by Rudy Sebastian and others at the University of Manitoba 
(who re-named it NUMMRIT). However, none of the original FORTRAN code is used in 
SpinWorks.  SpinWorks uses a completely original implementation of the NUMARIT algorithm 
in C++. 

A small library of sample spin systems is included with the program.  In a standard installation, 
these will be located in: C:\Program Files\SpinWorks\SpinSystems. 
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ABX Spectrum 
1. Start SpinWorks, but do not select any experimental data. 

2. In the Spin System menu select Edit Chemical Shifts…  You will then be presented with a 
dialog for entering chemical shift and other information describing the spin system.  For 
Group 1, enter 1 for the number of spins, A for the label, proton for the species and 1000 for 
the chemical shift.  For Group 2, enter 1 for the number of spins, B for the label, proton for 
the species and 1010 for the chemical shift.  For group 3, enter 1 for the number of spins, X 
for the label, proton for the species and 3000 for the chemical shift.  

3. In the Spin System menu select Edit Scalar (J) Couplings…  Enter –12 for J(A,B), 2 for 
J(A,X) and 10 for J(B,X).  Note that you must ONLY edit the numerical part of these 
entries.  Do NOT change the coupling labels such as J(1,2) J(A,B)  The program needs these 
labels to identify the couplings. 

4. In the Simulation menu select Run NUMMRIT Simulation.  In a few seconds, a simulated 
spectrum will appear on the screen.  Zoom in on the X multiplet at ca 6 ppm.  Use the 
cursors to measure the multiplet spacings.  Note that they do not relate all that well to the 
coupling constants!  This is a second-order or virtual coupling effect, and is much more 
common that one might think. 

5. Change the J(A,X) coupling to 0.  Use Run NUMMRIT Simulation in the Simulation 
menu again.  Note that the X multiplet is still a doublet of doublets, although it is coupled to 
only one of the other protons.  Closer examination of the multiplet shows that there are small 
satellite peaks (more properly called combination lines) displaced about 16 Hz. from the 
centre of the multiplet.  These lines are an important clue that the spectrum is second order, 
but are easily lost in baseline noise. 

6. Set the B chemical shift to be identical to the A chemical shift (Edit Chemical Shifts…) and 
re-simulate the spectrum (Run Simulation).  The X multiplet looks like a triplet (with small 
combination lines) despite the fact that it is only coupled to 1 other proton. 

Analysis of the Ortho-dichlorobenzene Spectrum 
1. Start SpinWorks, and make sure that it is in DISNMR mode (Options menu) 

2. Read the ODCB spectrum (File: Open…).  This is the file odcbs.001 usually located in 
C:\Program Files\SpinWorks\odcb.  The ODCB spectrum should now be displayed on the 
screen. 

3. Read in a starting spin system with by loading the odcb_ni file (File: Read Spin System 
File…).  You can examine the starting parameters with the shift and scalar coupling editors if 
you desire (Spin System menu).  Particularly note how explicit two fold symmetry is 
described with the 2*1 entries in the spins field.  Also note that in a symmetric spin system 
like AA′BB′, J(A′B′) will automatically be taken to be equal to J(AB) and that  

4. Select Edit Simulation Parameters… in the Simulation menu.  Set the Display Linewidth 
(Hz) setting to 0.06 (Yes, really). 
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5. Run the simulation (Simulation: Run NUMMRIT Simulation).  A simulated spectrum 
somewhat like the experimental will be displayed above experimental spectrum.  The vertical 
offset and scaling of the calculated spectrum can be adjusted with the blue +, -, up-arrow 
and down-arrow buttons on the toolbar. 

6. The left and right keyboard arrow keys will move a transition cursor across the simulated 
spectrum.  Assign lines to these transitions by pointing to the corresponding experimental 
peak and clicking with the right mouse button.  The peak picking routine is used to find the 
peak closest to the cursor position.  If no peak is found within a reasonable distance of the 
cursor the transition is assigned to the raw cursor frequency.  When a transition is assigned, a 
red line will be drawn between the transition and it’s corresponding peak.  Continue 
assigning all of the lines in the spectrum.  A misassigned transition can be deleted with the 
keyboard “d” key. 

7. In the Spin System menu use the Edit Chemical Shifts… and Edit Scalar (J) 
Couplings… dialogs to check the iterate boxes for both chemical shifts and all four 
couplings.  In the Simulation menu select Edit Simulation Parameters… .  Check the 
Optimize, Autoignore and Autoassign boxes.  

8. Run the simulation (Simulation: Run NUMMRIT Simulation).  The new spectrum that will 
be displayed should be a very close match to the experimental.  If not, check the simulation 
output (Simulation: List Simulation Output) for possible clues as to what might be wrong. 

9. It the simulation was satisfactory, load the new parameters (Spin System: Load Optimized 
Parameters)  into the spin system editor, and re-run the simulation.  Examine the simulation 
output (Simulation: List Simulation Output).  The RMS deviation between the 
experimental and calculated spectra should be less than 0.005 Hz at this point. 

10. Load these final optimized parameters (Spin System: Load Optimized Parameters) and 
save the new spin system to disk (File: Save Spin System As…) and likewise save the 
assigned transitions (File: Save Assigned Transitions As…) for future use. 

Analysis of the Fluorobenzene Spectrum 
1. The fluorobenzene spectrum supplied with SpinWorks is in XwinNMR format.  Using File: 

Open…, select the fid file of experiment number 1, and process with FT.  Phase the 
spectrum.  This spectrum was recorded on an Avance 300 using  gradients and a selective 
pulse to reduce the effective sample length and thus improve resolution (pulse sequence 
available on request).  Slight baseline distortions are observed due to the lock hold circuitry 
releasing immediately before acquisition.  This has absolutely no effect on spectra recorded 
at "normal" resolution.  Note that the spectrum shown below is an older one of the same 
sample recorded on an AM300. 

2. Read in the spin system file pfb.ss (File: Read Spin System File…).  Set the simulation 
display linewidth to  0.06 Hz (Simulation: Edit Simulation Parameters…).  Yes, we really 
can shim our 300 that well ☺. 

3. Run a non-optimized simulation. 



4. Assign as many transitions as possible.  Note that this is a more difficult analysis and that not 
all of the transitions can be assigned at this point. 

5. Check that all proton shifts and all couplings are selected for optimization (Spin System 
menu), and Set the simulation to run with optimization, autoassign and autodelete 
(Simulation menu). 

6. Run the simulation.  The fit at this point should be fair, but not great.  If it looks like a 
reasonable improvement then load the optimized parameters (Spin System menu), assign 
more of the transitions, and re-assign any that were obvious mistakes.  If the fit did not 
improve, it is probable that you did not assign enough lines or missassigned too many. 
Repeat steps 3 and 4. 

7. Run the simulation.  The fit should be quite good at this point.  Continue assigning lines and 
loading optimized parameters until the fit no longer improves.  The RMS at this point will 
typically be 0.006 Hz or better. 

8. Print the spectra. 

 

Spinworks NMR: C:\users\marat\programs\SpinWorks\fluorobenzene\1\fid    NUMARIT analysis of fluorobenzene in acet d6

PPM   7.18     7.16     7.14     7.12     7.10     7.08     7.06   

file: C:\users\marat\programs\SpinWorks\fluorobenzene\1\fid   expt: <>
transmitter freq.: 300.130000 MHz
time domain size: 8192 points
width:   189.83 Hz = 0.632477 ppm = 0.023172 Hz/pt
number of scans: 16

freq. of 0 ppm: 300.134930 MHz
processed size: 16384 real points
LB:   -0.070    GB: 0.6000
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Figure 4  Analysis of the fluorobenzene spectrum: high field portion.  This is the final fit after two rounds of 
iteration.  The RMS deviation between experimental and calculated peak positions is 0.004 Hz.  The Simulated 



spectrum has a calculated linewidth of 0.06 Hz. 
 

Spinworks NMR: C:\users\marat\programs\SpinWorks\fluorobenzene\1\fid    NUMARIT analysis of fluorobenzene in acet d6

PPM   7.42     7.40     7.38     7.36     7.34   

file: C:\users\marat\programs\SpinWorks\fluorobenzene\1\fid   expt: <>
transmitter freq.: 300.130000 MHz
time domain size: 8192 points
width:   189.83 Hz = 0.632477 ppm = 0.023172 Hz/pt
number of scans: 16

freq. of 0 ppm: 300.134930 MHz
processed size: 16384 real points
LB:   -0.070    GB: 0.6000

 

Figure 5  Low field portion of the fluorobenzene analysis 

HOGWASH Resolution Enhancement 
This is an implementation of Ray Freeman's HOGWASH (Second-Hand Experiment for the 
Elucidation of Partially resolved Data using an Iterative Procedure) algorithm incorporated into 
the Xsim/SpinWorks simulation package.  The original papers (J. Magn. Reson. 76, 476 (1988); 
56, 463 (1984); 56, 294 (1984)) should be consulted for details of how the technique works.   

The current implementation will process data with a real data size of up to 512k points (2 
Mbytes). This is not an array size limit but is included to force a degree of reasonableness.  

General Comments 
Be reasonable.  Resolution enhancement (especially non-linear processing) is not the solution to 
all resolution problems.  Enhancement factors of up to ca 5 are possible with careful application 
of the program to good data.  Users are strongly encouraged to read the homily on page 492 of 
the paper by Davies et al. (J. Magn. Reson.  76, 476 (1988)). 
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The choice of a synthetic vs. an observed mask (reference) peak depends on the nature of the 
resolution problem.  In cases where the peaks can reasonably be assumed to be Lorentzian (i.e., 
relaxation is the problem) then a synthetic Lorentzian mask is appropriate, although the synthetic 
mask peak may be either Lorentzian or Gaussian.   If field inhomogeneity is limiting the 
resolution, an observed mask (reference) peak is essential.  This must be a sharp single line of 
reasonable intensity in a clear region of the spectrum.  Note that TMS and other silylated 
reference compounds are usually poor choices because of the 29Si satellite peaks.  Both the 
spectral region being enhanced and the mask peak must be well phased and baseline corrected if 
necessary.  The compound chosen for the mask peak should be reasonably well T2 matched to 
the peaks to be enhanced, especially if a component of natural line width is to be removed from 
the spectrum.  If the mask peak has a considerably greater T2 than the compound under 
investigation, then only a small component of natural line width will be removed from the 
spectrum.  Any instrumental contribution will still be removed, however.  If the mask peak has a 
considerably shorter T2 than the compound under investigation, severe baseline distortion will 
result.  The frequency domain data (spectrum) must be very well digitized.  This may involve 
zero-filling the FID to 4 or even 8 times the original time domain size.  The spectrum should also 
have a reasonable signal to noise ratio and spectra with extremely high dynamic range should be 
avoided.  

It appears that another NMR processing package has also added HOGWASH processing (after 
being included in SpinWorks) and copied SpinWorks HOGWASH dialog box almost exactly. 

Using the Technique 
The spectrum to be enhanced should be processed normally using SpinWorks.  Pay particular 
attention to phasing and baseline.  If the acquisition time is considerably longer than the effective 
T2, some EM is appropriate to optimize the signal to noise ratio without excessively broadening 
the peaks. If an observed mask peak is being used, record its frequency or shift.   

Before using the enhancement package, there are a number of parameters that must be set.  
These can be set in the Edit HOGWASH Parameters...dialog of the File menu: 

Mask Peak Information 
When using a synthetic mask peak some degree of trial and error is required.  It is best to start 
with a fairly narrow mask and increase it until the desired degree of enhancement is obtained. 
Severe baseline distortion will result from the use of a too-wide mask peak.  For an observed 
mask peak, enter the position of the peak and the range over which the mask should be defined. 
This range should be at least 10 times the line width of the mask peak but is limited to 4000 
points.  The larger the range, the more slowly the program will execute.  

Loop Gain and Threshold  
Typical values for the loop-gain (γ) are less than 0.03, with 0.01 usually giving good results.  
Smaller values are better but slower.  The termination threshold is defined as a fraction of the 
tallest peak in the region being enhanced.  The threshold value depends on the dynamic range of 
the spectrum, and should be above the noise level - otherwise the program will attempt to 
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synthesize the baseline noise.  A threshold value just above the noise level is usually appropriate. 
The default value of 0.01 works well in most cases provided that the signal to noise ratio is good. 

The Reconstruction Line Width 
This is another variable that often requires some experimentation.  It must be several times the 
digital resolution, however.  A value 3 to 5 times narrower than the mask peak half-height width 
seems to give good results.  Too high a value will result is insufficient enhancement.  Too low a 
value may introduce false structure into the spectrum. 

Starting the Calculation 
The enhancement is started from Processing menu. The enhancement is only applied to the 
displayed region of the spectrum.  If other regions of the spectrum are to be enhanced, then they 
can be done serially, avoiding the need to apply the enhancement to baseline or uninteresting 
portions of the spectrum.  If the procedure, for whatever reason, messes-up the spectrum, it will 
be necessary to re-process the FID. (e.g. with the em+ft+pk command or with the processing 
panel). 

Saving Enhanced Spectra 
Enhanced processed spectra can be saved in JCAMP-DX format with the appropriate command 
in the File menu. Enhanced spectra are also saved in SpinWorks format if the auto save feature is 
turned on (Set Preferences… selection in the Options menu) 

Speed 
Typical calculation times are from a few seconds to a few minutes, depending on the problem 
and the computer used. 

 



Spinworks NMR: F:\pgh-VI.76\2\fid    Phil's fluorosugar in D2O, AMX500, 1-H

Hz  2200.0   2160.0   2120.0   2080.0   2040.0   2000.0   1960.0   1920.0   1880.0  1840.0 

file: F:\pgh-VI.76\2\fid   expt: <zg>
transmitter freq.: 500.139572 MHz
time domain size: 32768 points
width:  7042.21 Hz = 14.080577 ppm = 0.214911 Hz/pt
number of scans: 16

freq. of 0 ppm: 500.136716 MHz
processed size: 131072 real points
LB:    0.200    GB: 0.3500

 
 
Figure 6 HOGWASH processing of a fluorosugar spectrum, loop gain = 0.02, threshold = 0.01, reconstruction 
linewidth = 0.2 Hz., mask = N-Acetyl peak (1036.5 Hz), mask width = 20 Hz, zero-filling. to 128 k.; top: 
HOGWASH enhancement, middle: GM enhancement, bottom: normal processing (LB = 0.2).  This calculation 
required about 20 seconds on a 100 MHz Pentium under Windows NT 4.0. 

Application of HOGWASH Processing to the Indirect Dimension (F1) of 2D 
Spectra 
Multidimensional spectra often suffer truncation artifacts  (“sinc wiggles”) resulting from short 
acquisition times in the indirect dimensions.  The obvious solution of lengthening these 
acquisition times often results in an unacceptable increase in experiment time, and can decrease 
the signal to noise ratio.  Apodization, of course, can reduce or eliminate the artifacts at the 
expense of resolution.  Most NMR processing software includes linear prediction routines to 
extend the time domain data.  Linear prediction uses a set of coefficients derived from singular 
value decomposition (SVD) or maximum entropy methods‡ (the so-called Burg algorithm) to 
extend the data in the truncated dimensions.  However, “there is no such thing as a free lunch”, 
and linear prediction can create a number of well documented† but not often appreciated 
problems and artifacts. The Burg algorithm, in particular, is prone to problems such line splitting 

                                                 
‡ Not to be confused with Maximum Entropy Reconstruction. 
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† See, for example, A. S. Stern, K. Li, and J. C. Hoch, J. Amer. Chem. Soc. 124, 1982 (2002). 
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(introducing false multiplet structure) and frequency shifting. 

HOGWASH is modeled on a procedure used to solve an exactly analogous in radio astronomy.  
The finite aperture of the radio telescope relative to the wavelength creates artifacts similar to the 
truncation artifacts seen in multi-dimensional NMR.  In both cases, the instrument lineshape 
function can be calculated or measured, and can readily be deconvoluted out of the spectrum in a 
step-wise procedure.   For two-dimensional NMR, the instrument lineshape function can easily 
be calculated as the Fourier transform of a step function running from 0...t1, as field 
inhomogeneity usually has little effect for short values of t1.  Any additional apodization can be 
applied to this function, if desired.  This application of HOGWASH to the removal of truncation 
artifacts was first proposed by Keeler (J. Magn. Reson. 56, 463 (1984)) but, until now, the 
method has not been incorporated into readily available software packages.  Note that other 
lineshape problems, such as “phase twist”, can be treated with the same method (Shaka et al. J. 
Magn. Reson., 56, 294, (1984)). 

2D HOGWASH Parameter Selection 
The optimum parameters for applying HOGWASH to 2D truncation problems are somewhat 
different than when using the procedure for general 1D resolution enhancement.  The loop gain 
and termination threshold can be considerably higher.  The peak width used for reconstruction 
must be larger, on the order of the digital resolution in F1.  The default parameters are 
appropriate for many situations.  These parameters enable the 2D version of HOGWASH to run 
considerably faster than the 1D version.  For 2D, the default reconstruction lineshape is 
Gaussian.  This is primarily a cosmetic choice, as it seems to give nicer 2D contour plots than 
Lorentzian. 

Using the Technique 
• Process the 2D spectrum with normal window functions and the phasing mode set to none. 

(Edit menu, Edit 2D Processing Parameters…)  Use considerable zero filling in F1.  If the 
number of time domain points in F1 was 256, zero filling to 1K would be reasonable. 

• Phase the spectrum carefully. 

• In the Edit 2D Processing Parameters… dialog, set the phasing mode in both dimensions 
to constants, and set the F1 window function to none.  In the F1 HOGWASH Parameters, 
group set the Mask Width parameter to one half of the F1 size parameter.  The 
Reconstruction linewidth should be set to approximately the digital resolution (Hz/point) in 
the F1 dimension.  This may be 10 Hz to 20 Hz for an experiment like HSQC, but may be 1 
Hz to 5 Hz for a homonuclear correlation experiment such as COSY. 

• Process the spectrum in both dimensions.  You should see a phased 2D spectrum with 
truncation artifacts in F1.  Select the region to apply the HOGWASH processing.  This can be 
the entire spectrum, if desired.  Note that HOGWASH is applied to the entire F1 width, but 
only to the F2 region displayed on the screen. 

• In the 2D Processing sub-menu of the Processing menu, select HOGWASH F1.  The 
processing can be applied serially to other regions of the spectrum, if desired. 



• If selection of HOGWASH parameters was not appropriate, it will be necessary to re-process 
the data (use the Both button in the 2D Processing and Display dialog). 
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file: C:\data\marat\nmr\strych_hwtest\2\ser   expt: <invietgpsi>
transmitter freq.: 300.131407 MHz
time domain size: 2048  by  64 points
width:  2394.64 Hz = 7.978625 ppm = 1.169256 Hz/pt
number of scans: 8

F2: freq. of 0 ppm: 300.130006 MHz
processed size: 4096 complex points
window function: Sine Squared
shift:  90.0 degrees

F1: freq. of 0 ppm: 75.467749 MHz
processed size: 2048 complex points
window function: NONE
shift:  90.0 degrees

 
Figure 7 The high field portion of an HSQC spectrum.  64 Time domain increments were recorded in F1.  

1. (Top) Processing with no window function in F1.  Severe truncation artifacts are observed in F1. 

2. (Middle) Processing with 8 coefficient SVD linear prediction to 128 points in F1. 

3. (Bottom) HOGWASH Processing. The parameters were: loop gain = 0.10, termination threshold = 0.05, 
mask width = 512 points, reconstruction linewidth 15 Hz (Gaussian).  This calculation required 
approximately three seconds on a 1.7 GHz Pentium 4 under Windows 2000. 
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PPM   3.180     3.170     3.160     3.150     3.140    3.130    3.120    3.110    3.100    3.090    3.080     3.070   PPM

44.0

43.8

43.6

43.4

43.2

43.0

42.8

42.6

42.4

42.2

42.0

41.8

41.6

41.4

41.2

41.0

Figure 8  HOGWASH processing (expanded plot) showing resolution in F1 of approximately 15 Hz.  Only 64 
increments were recorded in F1 over a total width of 12,000 Hz, for a raw digital resolution of about 190 Hz. 
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SpinWorks 2.0:   Strychnine, short T1 for HW test column at 4.297557 ppm

PPM   140.0    130.0    120.0    110.0    100.0    90.0     80.0     70.0     60.0     50.0     40.0     30.0     20.0     10.0    0.0   

file: C:\data\marat\nmr\strych_hwtest\2\column2237.dx   expt: <invietgpsi>
transmitter freq.: 75.473348 MHz
time domain size: 64 points
width: 12561.88 Hz = 166.441299 ppm = 196.279408 Hz/pt
number of scans: 8

freq. of 0 ppm: 75.467749 MHz
processed size: 2048 complex points
LB:    0.000    GB: 0.0000

Figure 9  F1 columns extracted from an HSQC spectrum.  Top: no window function; Middle: Linear prediction 
followed by sine squared apodization; Bottom: HOGWASH processing.  Note that linear prediction has minimal 
effect on the resolution, but allows a less severe apodization by extending the effective acquisition time.  The “sinc 
wiggles” that remain in the outer edges of the HOGWASH spectrum result from using a mask width that was too 
narrow (512 points). 

Dynamic NMR Simulation 
SpinWorks can interface to two external programs for the simulation of exchanged broadened 
NMR spectra.  The first is the venerable old DNMR3 program of G. Binch and D. Kleier, while 
the second is the much newer MEXICO of Alex Bain.  The following summarizes the features 
and drawbacks of the two programs: 

DNMR3 
• Handles fairly large spin systems, including groups of equivalent spins (e.g. methyl groups.)  

It can also use symmetry (e.g. AA′) factoring, but the SpinWorks user interface does not 
include this. I doubt that symmetry factoring would be that useful for most dynamic NMR 
problems – anyone care to prove me wrong? The limit is 5 individual spins, or more if you 
have equivalence. 

• The program can handle both mutual (e.g. AB↔BA) exchange and non-mutual (e.g. 
AB↔CD) type exchanges. 
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• Up to three chemical configurations can be included. For example, AB↔CD↔EF. 

• The program can occasionally suffer from numerical instability. 

MEXICO 
• Handles very large spin systems, but does not include symmetry or equivalence factoring.  It 

can include weak coupling (X approximation) though.  Since memory in this program is 
dynamically allocated, the maximum size of the spin system is unknown.  With the 
SpinWorks interface, the practical limit is 5 individual spins.  Bigger systems can be handled 
by manually editing the mechanism file. 

• The program can handle both mutual and non-mutual exchange. 

• The program is currently limited to two chemical configurations. 

• The program is much faster and considerably more stable than DNMR3. 

• The treatment of relaxation is more accurate than that in DNMR3. 

• The complete MEXICO manual is available from Alex Bain at: 
http://www.chemistry.mcmaster.ca/faculty/bain 
 

General Notes on DNMR3 and MEXICO 
These programs run as external modules (.exe files) to SpinWorks.  SpinWorks expects to find 
these modules (dnmr3.exe and mexico.exe) in C:\Program Files\SpinWorks, the default 
SpinWorks installation folder.  If you installed SpinWorks in a different location, then you must 
configure this in the Set Preferences... selection in the Options menu.  Information is passed 
back and forth between these modules and SpinWorks via files, which are normally generated in 
C:\Temp.  For MEXICO, this scratch folder can be changed in the Set Preferences... selection 
in the Options menu. DNMR3, however currently requires the presence of the C:\Temp folder 
to operate.  All current Windows versions should have this folder.  If you don’t, then simply 
create it. The following files are generated: 

• Dnmr.mch  This is the input file for dnmr3, and is generated by the SpinWorks spin system 
editors. 

• Mexico.mch  This is the input (mechanism) file for MEXICO, and is generated by the 
SpinWorks spin system editors. 

• Dnmr.out.  This is the output spectrum from DNMR3, and is read by SpinWorks to create 
the displayed simulated spectrum.  This is an ASCII file and X,Y frequency-intensity pairs. 

• 1r  This is the digital spectrum produced by MEXICO.  It has exactly the same format as the 
file of the same name in Bruker’s XwinNMR.  The byte order is that of the INTEL processor, 
so, if you import this file into a XwinNMR data set the appropriate parameter in the procs 
file must be correct.  SpinWorks reads this file in order to display the simulated spectrum. 

Note that the versions of DNMR3 and MEXICO supplied with SpinWorks have been modified 
form the originals in order to work with SpinWorks.  The original MEXICO (for SGI IRIX, and 

http://www.chemistry.mcmaster.ca/faculty/bain


designed to work in conjunction with Bruker’s XwinNMR, or, I hate to admit, MestRC) is 
available from Alex Bain at: bain@mcmaster.ca. The original DNMR3 program is available 
from numerous places on the web. 

Note that all valid DNMR/MEXICO parameter sets are also valid for NUMMRIT calculations,  
and that any NUMMRIT parameter set that would be suitable can be turned into a 
DNMR/MEXICO parameter set by adding the appropriate DNMR parameters (Spin System 
menu). 

A simulation pop-up is available from the toolbar. 

With this panel you can run any of the simulation routines.  The rate constant for DNMR3 and 
MEXICO simulation can be varied, and transition assignments for NUMMRIT can be auto-
assigned or deleted.  The χ2 and RMS deviation between the experimental and simulated spectra 
for DNMR3 and MEXICO simulations can be examined with the Chi Squared button.  The 
Assign, Delete and Chi Squared functions apply only to the displayed region of the spectrum. 

The Find Cursor button is used in NUMMRIT calculations to jump the transition cursor into the 
currently displayed region. 

 

The following is a summary of the simulation panel functions: 

NUMMRIT Starts a NUMMRIT simulation using the existing spin system definition.  Since 
all DNMR3 and Mexico spin systems are also valid  NUMMRIT spin systems, 
this button will also work in DNMR3/MEXICO mode 

DNMR3 Starts a DNMR3 simulation.  SpinWorks must be in DNMR/MEXICO mode and 
a valid DNMR3 spin system must exist. 

 
Kirk Marat Page 52 7/23/2005 



 
Kirk Marat Page 53 7/23/2005 

MEXICO Starts a MEXICO simulation.  SpinWorks must be in DNMR/MEXICO mode and 
a valid MEXICO spin system must exist. 

K(1,2)       Sets the rate constant for a two site DNMR3 or MEXICO simulation.  For 
systems with more than 2 sites use the Edit DNMR/MEXICO Parameters… 
dialog in the Spin System menu. 

Edit Group These three buttons are used to edit the simulation parameters, chemical shifts of 
scalar couplings.  These start edit dialogs identical to those that can be started 
from the Spin System menu. 

Assign       This button is used to autoassign peaks in the displayed region of the spectrum.  
This would be used in an iterative NUMMRIT analysis.  The fit must be 
reasonably good for this feature to work, so a few rounds of manual assignment 
and iteration may be required first. 

Delete       Deletes assignments in the displayed region. 

Find Cursor Moves the transition cursor from wherever it is into the displayed region of the 
spectrum.  This eliminates the older practice of leaning on the arrow key to 
accomplish this task. 

Chi Squared Displays the relative fit between the simulated an experimental spectrum over the 
displayed region.  Primarily used for DNMR3 and MEXICO calculations. 

Treatment of Relaxation 
DNMR3 treats relaxation in a very rudimentary fashion.  An effective T2 determines the 
linewidth of each spectral line in the absence of chemical exchange or at the extreme fast 
exchange limit.  MEXICO’s treatment of relaxation is far more sophisticated.  A separate T1 
value can be entered for each nucleus.  T2 is considered to be equal to T1.  T1, however, also 
affects the linewidth of any coupled nuclei, and this is properly handled in MEXICO.  An 
example of this is the self decoupling of 14N from 1H.  With SpinWork’s DNMR/MEXICO 
interface, a single T1 is entered, and is considered to be equal for all nuclei.  This should be 
adequate for most applications.  If you find it necessary to enter separate T1s, it is a simple 
matter to manually edit the MEXICO mechanism file. (Spin System menu). 

Example Files 
A number of sample spin system files suitable for DNMR calculations are included in the 
DNMR folder of the standard installation (C:\Program Files\SpinWorks\dnmr).  These have the 
additional necessary DNMR parameters. These example files currently include: 

• dnmr_test3.ss  AB to BA mutual exchange. This file is suitable for both DNMR3 and 
MEXICO. 

• dnmr_test4.ss    AB to CD non-mutual exchange.  This file is suitable for both DNMR3 and 
MEXICO. 

• dnmr_test5.ss    A2BB2 to B2A2 mutual exchange.  This file is suitable for DNMR3 but cannot 
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be used for MEXICO because there is more than one spin in a group.  MEXICO could 
probably handle this system as ABCD to CDAB with δA = δB and δC = δD; J(A,B) = 
J(C,D) = 0, and J(A,C) = J(B,C) = J(A,D) = J(B,D).  The permutation vector for the 
exchange would be 3412.  Give this a try, if you like. 

• dnmr_test6.ss  AB to CD to EF three site non mutual exchange.  This file is suitable for 
DNMR3 only as MEXICO is currently restricted to two sites. 

• dnmr_test7.ss    ABC to BAC mutual exchange.  Suitable for both DNMR3 and MEXICO. 

• dnmr_test8.ss   ABC to BAC to CAB three site mutual exchange.  DNMR3 only. 

Parameters Required for DNMR Simulation 
The spin system is described in the same manner as it would be for a high resolution 
(NUMMRIT) simulation.  There are, however, a couple of differences, primarily effecting the 
chemical shift editor.  For MEXICO, the number of spins in each group is limited to one.  For 
DNMR3, this can be 1, 2, or 3.  The species identifier is treated quite differently.  Rather than 
specifying a different nuclear species (e.g. 13C vs. 1H), the species identifier specifies a different 
chemical species for cases of non-mutual exchange (e.g. AB↔CD).  For mutual exchange all 
nuclei must be the same species (MEXICO can handle weak coupling, but it must be entered 
differently).  For the AB↔CD case, the first two nuclei would be entered as species 1, while the 
second two would be entered as species 2.  The actual symbols used to describe the species don’t 
matter, as long as they are different.  Once correctly described in the chemical shift editor, the 
coupling constant editor will recognize all valid coupling constants.  For instance, for the 
AB↔CD case, the coupling constant editor will have entries for J(A,B) and J(C,D), but not for 
J(A,C) etc.  In effect, you are entering two separate spin systems.  In addition to these 
differences in defining the spin system, there are a number of DNMR specific parameters that 
must be entered into the Edit DNMR Parameters... dialog of the Spin System menu. 

• T2 (for DNMR3) or T1 (for MEXICO)  For DNMR3, this parameter defines the linewidth in 
the absence of exchange. T2 = 1/(πΔν1/2).  For MEXICO, this is the actual (or more likely 
estimated) T1 value of the nuclei.  T2 is assumed to be equal to T1 and both effect the 
linewidth in the absence of chemical exchange.  The current parameter editor sets the T1 of 
all nuclei to be equal, but you can override this with a manual edit of MEXICO’s mechanism 
file.  Future versions will allow you to enter separate T1 values for each nucleus. 

• Mutual Exchange (checkbox)  This parameter defines whether the exchange is mutual, or 
not. 

• Rate Constants  For mutual exchange only a single rate (K(1,2)) can be defined.  For non-
mutual exchange, the forward rate for the exchange between site should be entered. 

• Number of Species  Can be set to either 2 or 3.  The current MEXICO release can only 
handle 2 species cases. 

• Permutation Vectors  This string of integers defines the identity of the nuclei after 
exchange.  The first permutation vector is taken to be the unity permutation 1,2,...,n where n 
is the number of nuclei.  DNMR requires these vectors only for mutual exchange, one vector 



for two site exchange and two vectors for three site exchange.  For an AB↔BA mutual 
exchange, the permutation vector would be 2,1.   MEXICO requires a permutation vector for 
non-mutual exchange as well, but can usually be set to the unity permutation.  Please see the 
MEXICO manual for complete details.  Note that SpinWorks and DNMR3 numbers the 
nuclei starting with 1, and the permutation vectors are internally converted into 
MEXICO’s 0 based counting . 

• Populations  These are the populations of the sites for cases on non-mutual exchange. 

 
DNMR Tutorial 

AB↔BA Mutual Exchange 

1. Start up SpinWorks with no experimental data.  Use the Options menu to set the simulation 
mode to DNMR3/MEXICO. 

2. Under the Spin System menu choose Edit Chemical Shifts...  Enter two nuclei as follows: 

 

3. Also under the Spin System menu, choose Edit Scalar (J) Couplings...  Set J(A,B) to 12 
Hz.  Remember only to change the numeric part of the coupling constant field. 

4. Use the Edit DNMR Parameters... dialog in the Spin System menu to set the following 
DNMR parameters:  K(1,2) = 5; Permutation Vector (2) = 2 1 and T2 = 1 (the default).  
Make sure that the mutual box is checked, and that the number of chemical configurations 
(sites) is set to 2.  Since this is mutual exchange, the population values do not need to be set. 

5. Use the Run DNMR simulation command in the Simulation menu to run the simulation.  A 
black command interpreter window will appear briefly, and a simulated spectrum should 
appear.  You can also run DNMR from the Simulation pop-up panel that can be started form 
the Yellow Sim button on the toolbar. 

6. Run the same calculation with MEXICO by using the Run MEXICO simulation command 
(Simulation menu).  If you see a spectrum here and in step 5, then both DNMR3 and 
MEXICO are installed properly and are working.  Use List Simulation Output command 
(Simulation menu) to view the text output (e.g. for possible errors) from either of these 
programs. 

7. The default spectral width (5000 Hz) is a bit big for this simulation, so let’s reduce it.  Use 
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the Edit Simulation Parameters... dialog in the Simulation menu to reduce the Display 
Width to 1000 Hz and the Offset to 1000 Hz.  Recalculate the spectrum with either DNMR3 
or MEXICO. 

8. Experiment with the effect of changing the rate constant on the spectrum.  You can save any 
of  your calculation to stacked trace with the Copy Simulated to # commands in the view 
menu. 

9. Print the spectrum, if desired. 

ABC ↔ BAC Mutual Exchange 

1. Using the spin system editors, Set up an ABC spin system with δA = 500 H, δB = 550 Hz 
and δC = 800 Hz.  Set J(A,B) = 12 Hz, J(A,C) = 10 Hz and J(B,C) = 2 Hz.  Using the DNMR 
parameter editor (Spin System menu) set Permutation Vector 2 to 2 1 3 and the rate 
constant to 5 s-1.  Chemical Configurations (2 or 3) should be set to 2.  This is one of the 
standard DNMR spin systems distributed with SpinWorks, so it can also be set up by reading 
in the spin system from disk. Use the Read Spin System… selection in the File menu.  The 
file is dnmr_test7.ss and should be located in C:\Program Files\SpinWorks\dnmr. 

2. Run the simulation with both MEXICO and DNMR3.  Experiment with different values of 
the rate constant.  The spectra should look something like the following: 



PPM   1.60   1.50   1.40   1.30   1.20   1.10   1.00   0.90

file: (null)   expt:
transmitter freq.: 500.000000 MHz
time domain size: 0 points
width:  1000.00 Hz = 2.000000 ppm
number of scans: 0

freq. of 0 ppm: 499.999500 MHz
processed size: 16384 real points
LB:    0.000    GB: 0.0000

SpinWorks/MEXICO Dynamic NMR simulation:  ABC to BAC

ABC

10 s-1

100 s-1

1000 s-1

20000 s-1

3. Notice that the two outer lines of the C multiplet remain sharp.  Using simple αβ type spin 
basis functions, explain why this is so. (Chem. 2.460 students take note ☺) 

4. Switch the simulation  mode to NUMMRIT (Options menu).  Re-run the simulation with 
Run NUMMRIT Simulation (Simulation menu).  Notice how easy it is to switch back and 
forth between the two calculation modes.  For a strongly second order exchanging system, a 
good technique is to analyze the slow exchange spectrum with NUMMRIT first to obtain 
accurate spectral parameters.  It is then an easy matter to switch to DNMR or MEXICO to 
simulate the exchanging spectra. 

ABC: Effect of T1 Relaxation (MEXICO) 

While not exactly Dynamic NMR, the following is an interesting demonstration. 

1. Set up the ABC spin system exactly as in the previous example (dnmr_test7.ss).  Set the rate 
constant to 0, but the other dnmr parameters should be the same. 

2. Simulate the spectrum using MEXICO.  A nice, non-exchange broadened spectrum should 
be displayed. 

3. Select the View or Edit MEXICO Mechanism File command in the Spin System menu.  
Find the relaxation rates line for the first site, and set the relaxation rate (not the exchange 
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rate) for nucleus “C” (the third number on the line) to 10000.0.  You do not need to change 
the rate of the second site as this is mutual exchange.  (Read Alex’s MEXICO manual, if you 
need help understanding the format of the mechanism file). 

4. Re-simulate the spectrum with MEXICO.  What do you see?  Why? 

AB to CD Non Mutual Exchange 

This is a simulation of two different spin systems in equilibrium. 

1. Read in the spin system file dnmr_test4.ss (it should be in C:\Program 
Files\SpinWorks\dnmr). 

2. Using the spin system editors (in the Spin System menu) examine how the shifts and 
couplings are entered for a system of this type.  Especially note how the species designator is 
used for the chemical configuration (site) and how the coupling editor only shows couplings 
within a chemical species. 

3. Use the DNMR parameter editor to examine the dnmr parameters. 

4. Simulate the spectrum with DNMR3 and MEXICO.  Experiment with different values of the 
rate constant and populations. 

Running User Supplied External Modules 
A new feature in SpinWorks as of version 1.3 is the ability to use SpinWorks as an interface to a 
user supplied external simulation module.  These modules can be in written in any language (C, 
C++, Fortran, Java, etc.), provided that certain conventions are observed.  This feature has not 
been thoroughly tested.  I would enjoy hearing from anyone that has a particular simulation 
program that they would line to use with SpinWorks. 

1. The program must produce its output (digital spectrum) as an ASCII (text) table of 
frequency/intensity (x,y) pairs.  The location of this file must be in SpinWork’s scratch 
folder.  This is set with the Set Preferences… selection in the Options menu.  The name of 
this file must be entered into: User Module Output File, and note that a leading backslash is 
necessary. 

2. If your external program requires an input file (spin system parameters or whatever) the 
name is entered into: User Module Input File, again with a leading backslash.  If your 
external program does not require an input file name (perhaps because it has been hard coded 
into the program ) then enter none.  Note that SpinWorks produces a number of spin 
system files that, depending on exactly what sort of calculation that you are doing, you may 
be able to use as your input file.  These are called “spin_system”, “dnmr.mch” and 
“mexico.mch”.  If none of these are suitable, then it is necessary to edit your own input file 
by starting an editor (e.g. Notepad or WordPad) session and saving your input file before 
each simulation.  You can also select whether your program requires its input file as a 
command line argument or with redirection from “standard input”, UNIX style. 

3. The number of data points (size), the spectral width and the frequency of the left-most point 
in SpinWorks (Simulation menu -> Edit Simulation Parameters…) must match that 



produced by the external program. 

Here is a typical setup: 

 
 
In this case, the program executable is called  “secquad.exe” and is located in C:\Program 
Files\Spinworks.  The program produces an output file called  “sequad.out” located in 
C:\Temp.  The program uses as input a manually edited text file called “sequad_test.txt” and 
uses the Redirect operator “<” as part of the input line. 

If you put SpinWorks into simulation debug mode (Simulation menu) you can see that the actual 
command line generated by SpinWorks is: 

C:\Program Files\SpinWorks\secquad.exe < C:\Temp\sequad_test.txt > simout.txt. 

Summary of Menu Bar Commands 
File Menu Commands 
• Open…  Specifies which NMR data set to open.  The standard Windows File Open dialog 

will prompt you for the following options: 

1. File Name  Type or select the filename you want to open.  This box lists files 
with the extension you select in the List Files of Type box. The file that you select 
depends on the data format.  For UXNMR/XwinNMR and Varian data select the 
“fid” file of the appropriate experiment directory.  For DISNMR and DISMSL data 
select the name of the data set file (e.g. MYDATA.001).  For JCAMP DX spectra 
select the data file, usually with the .dx extension.  This extension is not, however, 
required. 

2. Files of Type  Select the type of file you want to open.  For NMR data this 
should be “all files” i.e. blank or *.*: 

3. Look in  Select the directory in which SpinWorks stores the file that you want to 
open. 
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• Select Block (Varian)…  Varian “fid” files can actually contain more than one fid.  This 
will be the case for arrayed parameters or experiments such as DEPT.  Use this command to 
select which of the fids should be read. 

• Save and Save as…  These functions save the processed spectrum in JCAMP DX format.  
To read JCAMP DX spectra with SpinWorks set the appropriate data type with the Options 
menu.  SpinWorks can also read JCAMP DX spectra create by XwinNMR and XwinNMR 
can convert JCAMP DX spectra created by SpinWorks.  The data sets will have a .dx file 
extension.  Note that these functions always use JCAMP DX format irrespective of the Data 
Format setting.  The JCAMP-DX format used here is a subset of the full definition of the 
format.  In particular, the data are not compressed and compressed data produced by other 
programs cannot be read.  JCAMP-DX files saved by SpinWorks can be read by XwinNMR 
(although it may gripe a bit about missing parameters).  JCAMP-DX files saved by 
XwinNMR can be read by SpinWorks provided that they are stored in uncompressed format. 
 In XwinNMR this would be Compression Mode: FIX. 

• Save Extracted Rows or Columns...   Rows or columns selected with the right mouse 
button can be saved as JCAMP_DX files by using the Save Displayed Columns or Save 
Displayed Rows selections in the File menu.  These spectra will be saved with names like 
row482.dx in the folder containing the folder containing the current raw data.  The titles in 
these files will have the chemical shift of the extracted row or column attached.  These rows 
and columns can then be read by SpinWorks in 1D mode, but be sure to set the data type to 
JCAMP-DX first. 

• Read Spin System File…  Reads in a spin system definition (shifts, couplings, etc.) for a 
simulation.  A standard Windows File Open dialog will prompt you for the name and 
location of the file.  The current spin system is also always saved in a file called 
“spin_system” in the current working directory, and is updated any time the spin system 
changes (e.g. with the commands in the Spin System menu).  Files generated by the spin 
system editor in Xsim are compatible with SpinWorks.  If you have the Simulation Mode 
(Options menu) set to DNMR any additional DNMR parameters stored with the file will 
also be loaded.  If you have no experimental data loaded, a descriptive title stored with the 
spin system file will also be loaded.  The title of any experimental data will have precedence 
over this title, however. 

• Save Spin System As…  Saves the current spin system to a named file on disk.  A standard 
Windows File Save dialog will prompt you for the name of the file and the folder to save it 
in.  This command is primarily used to save a spin system for future use and reference.  Files 
saved with this command can be read with the Read Spin System File… command.  This 
file is in plain ASCII text and can be examined with any text editor.  These files are also 
compatible with the Xsim program.  Hint:  If you use a consistent file extension for your 
spin system files (such as .ss)  they will be easy to recognize, and you can use the explorer to 
associate your favorite editor (e.g. notepad, wordpad, etc.) with this file type.  If you have the 
Simulation Mode (Options menu) set to DNMR, any DNMR parameters will be stored 
with the parameters.  The data set title (from the experimental data set) will also be stored 
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with the spin system file.  If you have not loaded an experimental data set, you can enter a 
title for the spin system file with the Plot Title... selection in the Edit menu. 

• Read Assigned Transitions…  Reads a file of assigned transitions into the program.  The 
current list of assigned transitions is also stored into a file called “asn_trans” in the current 
working directory (usually the folder containing the experimental data) whenever an 
optimizing simulation is run.  Transition files produced by SpinWorks are ASCII text files 
compatible with Xsim 

• Save Assigned Transitions As…  Saves the currently assigned transitions to a named file 
on disk.  This command is primarily used to save the assigned transitions for future use. Files 
saved with this command can be read with the Read Assigned Transitions… command. 

• Print…  Prints the current spectra.  Use the Edit Plot Options and Parameters… 
command in the Edit menu to change various aspects of the output. 

• Print Preview  Exactly what it says. 

• Print Setup…  Sets various printer dependent parameters (which tray to use, etc.). 

• Delete Processed Data   If SpinWorks has been set to automatically save processed data 
(Options menu), any processed data generated by SpinWorks can be deleted with this 
command. 

• The most recently used file list.  The last eight NMR data sets used by SpinWorks are 
displayed for possible selection as the current data set. 

• Exit 

Edit Menu Commands 
• Copy Metafile to Clipboard  Makes a copy of the currently displayed spectra to the system 

clipboard, for possible inclusion in other documents. 

• Copy MetaFile to File…  Saves a metafile copy of the current spectra as a named file.  The 
format is Windows Enhanced Metafile and the file has an emf extension to indicate this.  
This method currently seems to work a bit better than the clipboard for including spectra in 
Word or PowerPoint. 

• 1D Processing Parameters……  Use this command to view or change the parameters used 
to process spectra.  Note that in future versions the peak picking parameters may be moved to 
a separate menu.  The processing parameters are: 

1. Line Broadening (LB) in Hz.  The amount of broadening to be applied in an 
exponential multiplication or Gaussian multiplication of the fid.  Used in the EM+FT, 
GM+FT commands, etc. 

2. Gaussian Broadening. (GB)  The Bruker style Gaussian broadening factor to be 
applied to the fid.  Used in conjunction with a negative LB value to provide resolution 
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enhancement.  See the description of the GM+FT (Processing menu) command for 
details.  Only used by the Lorentz to Gauss window function. 

3. Size  The number of complex data points in the transform.  The number will be 
rounded up to the nearest power of 2.  e.g. A size value of 32000 will be rounded to 
32768 and will give 32k real and 32k imaginary points after the transform.  A Size 
value greater than TD/2 results in zero-filling. 

4. Peak Pick Minimum Intensity  The intensity threshold relative to the most 
intense peak in the spectrum for peak picking.  Usually adjusted graphically by 
dragging the threshold line on the screen. 

5. Peak Pick Noise Threshold  provides a degree on noise discrimination in peak 
picking.  The default value is 0.5 and may have to be lowered for spectra that have 
broad peaks (relative to the digital resolution) or that have high degrees of zero-
filling. 

6. ABS Poly. Degree  The degree of the polynomial used in the ABS and ABSS 
routines.  The default value is 3 and the maximum value is 6. 

7. Left Shift FID (points):  Applies a left shift to the FID prior to transform.  This 
can be useful in solid state NMR for aligning an echo top.  A negative number will 
produce a right shift of the data, with zeros filled in from the left.  Note that for 
complex (quadrature) data this parameter is actual the number of complex pairs. 

8. Zero Order Phase:  The zero order or frequency independent phase constant.  
Applied with the phase with last constants selection in the Processing menu, or 
any transform command that applies phasing (see description of Processing menu). 

9. First Order Phase:  The frequency dependent phase constant.  Applied with the 
phase with last constants selection in the Processing menu, or any transform 
command that applies phasing (see description of Processing menu). 

10. Frequency of 0 ppm (MHz):  The reference frequency for the spectrum. Tis 
value can be used to reference spectra that don’t have a convenient reference line.  
Particularly useful in solid state NMR. 

11. Solvent Filter  A low pass filter that can be used to remove a strong signal at the 
centre of the spectrum.  Primarily cosmetic. 

12. Forward Linear Prediction   Well, If you really want to try…  See the LP 
section of the manual for details.  The linear prediction is applied by the LP Process 
1D (Forward) selection in the Processing menu. 

13. Backwards Linear Prediction  This function can be used to replace a few 
corrupted points at the beginning of an FID with values obtained by linear prediction 
of the following points.  This is useful for removing the effects of probe ring-down, 
wide line background, etc.  The default values should be good for many cases.  Be 
careful that the number of input points does not extend too far into the noise.  
Increasing the number of coefficients can produce instabilities.  The linear prediction 
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is applied by the LP Process 1D (Backward) selection in the Processing menu. 

14. Acquisition Mode  The type of quadrature detection used.  This parameter should 
be correctly extracted from the data parameters, but is included here just in case it 
isn’t. It does not need to be changed unless there is a problem. 

• 2D Processing Parameters…  Use this command to edit the processing parameters for 
both dimensions of 2D experiments.  The parameters are described in detail in the 2D 
processing section of this manual.  This dialog may also be started from the "stay-up" 2D 
processing dialog. 

• Plot Title…  Use this command to edit the title of the current data.  This information is 
displayed at the top of the data window and is included on the plot.  The default is to use the 
title stored with the data.  Note that currently only the first line of the title file is read and 
displayed. 

• Plot Options and Parameters…  edits sizes, etc. for the plots.  These should be self-
explanatory.  In order to change to portrait orientation, uncheck the box labeled Force 
Landscape Orientation.  The MetaFile Resolution parameter sets the resolution of any 
saved MetaFile (e.g. for incorporation into a document) relative to the screen.  The default 
value of 2 should be suitable for most applications.  Higher values give more resolution but 
create much bigger MetaFiles. 

• HOGWASH Parameters… Use this dialog to set and adjust various parameters used by the 
HOGWASH resolution enhancement command.  These parameters are detailed in the 
separate section dealing with HOGWASH. 

View Menu Commands 
• Toolbar  Use this command to display and hide the Toolbar, which includes buttons for 

some of the most common commands in SpinWorks, such as File -> Open.  A check mark 
appears next to the menu item when the Toolbar is displayed. 

• Status Bar  Use this command to display and hide the Status Bar, which describes the action 
to be executed by the selected menu item or depressed toolbar button, and keyboard latch 
state. A check mark appears next to the menu item when the Status Bar is displayed.  The 
current data format (e.g. DISNMR, UXNMR, etc., status messages (e.g. FT complete) and 
one line help messages are also displayed. 

• Show Simulated  Use this command to turn the display of the simulated (calculated) 
spectrum on or off.  This will affect both the display and the print.  The default state is ON, 
and a check mark is used to indicate this fact. 

• Show Inset Box  For 1D spectra it is possible to transfer an expanded region of the 
spectrum to an inset box, using the appropriate button on the toolbar.  This command will 
toggle any inset spectrum on or off.  See the section on 1D processing for a description of the 
inset box. 
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• Rotate 2D  This selection will cause 2D spectra to be displayed and printed with the F1 axis 
horizontal.  A check mark and the axis labeling indicated whether the spectra are rotated or 
not.  Note that this option must be turned off for interactive 2D phasing. 

• Set Fixed Limits and Set Fixed Scale  Use these commands to set convenient plot limits 
and expansion scales for routine spectroscopy.  Once an expansion scale has been set (e.g. 10 
Hz/cm) it is possible to scroll through the spectrum at the same scale by using the slider at 
the bottom of the data window. 

• Copy Experimental to #2…#4  Use these commands to make a copy of the processed 
experimental spectrum into one of three alternate traces.  This makes it possible to compare a 
series of spectra such as a temperature run or DEPT sequence on the screen.   Zooming, 
scrolling and vertical scaling commands affect all of the traces.  If it is necessary to adjust the 
vertical scaling of an individual trace, use the Scale Stacked Traces… command of the View 
menu.  The Subtract Trace 2 from Experimental command in the Processing menu can be 
used to produce a difference spectrum. 

• Copy Simulated to #2…#4  Similar to the above, but copies the simulated spectrum to one 
of three alternate traces.  These alternate traces can contain a mixture of simulated and 
experimental spectra. 

• Add Simulated to #2  Occasionally it is handy to break a simulation up into a number of 
smaller simulations.  This command allows you to build up a composite simulation in trace 2 
by adding the current simulated spectrum to the spectrum in trace 2.  Stated another way, 
trace2 = trace2 + (factor * simulated).  The factor or coefficient for the simulated can be 
changed from the default value of 1 in the Scale/Shift Stacked or Inset Traces… dialog. 

• Copy Simulated to Experimental   This copies the current simulated spectrum into the 
experimental trace, overwriting any experimental data.  This allows one to use the integration 
and peak picking routines on simulated data, primarily for teaching purposes. 

• Scale/Shift Stacked or Inset Traces…This command starts a modeless dialog box which 
allows one to adjust the vertical scale of the individual stacked traces, if necessary.  Each 
click of a + button increases the vertical scaling by 10% while the – button decreases the 
scaling by 10%.  You can also shift the individual traces up and down the screen if desired.  
The Add Factor value id the coefficient used for adding a simulated spectrum to trace 2.  
The default value is 1.  After changing this value you must click on the Apply button for the 
change to have effect.  The Inset Trace grouping is used to adjust the vertical scaling of any 
inset trace.  The  + and - buttons adjust the scaling in small steps, while the reset button can 
be used to return the scaling to a value identical to the experimental spectrum. 



 

• Delete Trace #2…4  Use these commands to delete any stacked traces.  The current 
experimental spectrum is not affected. 

Option Menu Commands 
• Simulation Mode  Use this command to set the simulation mode to either NUMMRIT, 

which is used for spin simulation, iterative analysis, and double resonance simulation, or to 
DNMR/MEXICO which is used to simulate dynamic NMR experiments.  The default mode 
is NUMMRIT. 

• Data Format  (sub menu) This menu selection sets the format of the current data.  
Currently supported data formats are: Bruker UXNMR/XwinNMR, Bruker DISNMR, Bruker 
DISMSL and Varian UNITY/INOVA.  JEOL generic data is supported, but not thoroughly 
tested.  Current JEOL spectrometers do not record their data in this format but can convert it 
to this format.  It may be necessary to reverse (Processing menu) converted JEOL data after 
transform. TECMAG NTNMR data is supported, but hasn’t been thoroughly tested.  JCAMP 
DX format is used to read spectra saved by SpinWorks or JCAMP DX files from other 
sources (e.g. XwinNMR).  The File: Save As... function always saves data in JCAMP DX 
format irrespective of the Data Format setting.  The Data Format sub-menu is also used to 
switch the program from 1D to 2D modes.  Note that you must select the data format 
(spectrometer type and 1D vs. 2D) before reading the data.  However, from SpinWorks 
2.4 on, this selection of 1D vs. 2D and Bruker vs Varian is automatic. 

• Peaks and Match  These options turn ON and OFF the display of picked peak frequencies 
and match lines between experimental and simulated spectra. 1D mode only. 
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• Tracking Cursor  This option selection turns ON and OFF a tracking vertical reference line. 
 This can be very useful for measuring frequencies, frequency differences, etc.  The default 
value is OFF. 

• Set Preferences…  A number of start-up preferences can be set with this dialog: 

 

• Default Data Folder   Sets the initial data folder (directory) for the File Open 
command.  e.g. F: or D:\data\marat\nmr.  

• Processed Data   Two check boxes that determine whether processed data 
should be stored to disk and automatically loaded upon selection of a data-set.  These 
features only apply to Varian and Bruker XwinNMR/UXNMR data.  Occasionally, an 
inconsistently processed data set can cause the Auto Load feature to fail and 
SpinWorks will crash.  This most often happens when the parameters say that the data 
were of one type (e.g. States), but this designation was wrong and the selection was 
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overridden when the data were processed.  If this happens, re-start SpinWorks and 
turn the Auto Load feature off before selecting the data set. 

• Data Format  Sets the default data format at start-up.  

• Simulation Mode  Sets the default simulation mode (currently NUMMRIT or 
DNMR/MEXICO).  The default is NUMMRIT. 

• Alternate Peak Rotation  Overcomes a bug in some printer drivers (not 
normally necessary). 

• Default Scratch Folder   Sets the scratch directory (folder) used by some of the 
calculations.  The default is C:\Temp is should be acceptable for most users. 

• Default External Module Folder  Sets where the program expects to find 
external simulation modules such as DNMR3 and MEXICO.  The default is 
C:\Program Files\SpinWorks. 

• User Supplied Module Name   The executable file name (e.g. secquad.exe) of a 
user supplied simulation routine. 

• User Module Input File  The name of any input file required by the external 
module.  Set to none if your program requires no input name to be specified. (Either 
it doesn’t need one or the name is hard-coded into the program.)  The default is none. 
Note that the leading “\” character is required. 

• User Module Output File  The name of the output file generated by your 
external program.  This is a text file and will consist of frequency-intensity pairs, as 
described in the separate section on using external modules. The leading “\” character 
is required. 

• Use Input Redirect Operator “<”  This check box determines whether the input 
file (if any) has its input redirected from standard input (UNIX style)  or as a specific 
command-line argument. 

• Acrobat Reader    Not currently used.  If your computer knows what reader to 
associate with a “pdf” file, then the pdf manual should display properly. 

Spin System Menu Commands 
• Edit Chemical Shifts…  This command starts the chemical shift editor, where it is possible 

to enter the number of spins, chemical shift, group label, and species identifier for a group.  
The standard spin systems provided in the simulation tutorial give good examples of the 
required format. 



 

• Edit Scalar (J) Couplings…  This command starts the coupling editor, where all J 
couplings relevant to the spin system can be edited.  Note that the chemical shift editor must 
be called first.  Only the numeric parts of the fields should be edited.   

 

• Edit Dipolar (D) Couplings… Dipolar coupling is now supported for NUMMRIT (but not 
DNMR or MEXICO) calculations.   

• Edit Quadrupolar (Q) Couplings… Quadrupolar (Q) coupling is not yet implemented. 

• Edit Species Spin Values…  This editor sets the spin quantum number for each group of 
nuclei.  The default is all groups spin ½. 

• Edit DNMR Parameters...   This editor is used to set the necessary dynamic NMR 
parameters for DNMR or MEXICO simulations.  See the Dynamic NMR section for details 
of the parameters. 

• Load Optimized Parameters  This command loads the post-optimization parameters into 
the coupling and shift editors for further refinement.  They can then also be saved with the 
Save Spin System… command of the Edit menu. 

Simulation Menu Commands 
• Run NUMMRIT Simulation  This command calculates a simulated spectrum based on the 

current spin system, Simulation Parameters and Simulation Mode (Options menu) After 
a calculation the calculated (simulated) spectrum will be displayed along with the 
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experimental spectrum (if any). 

• Run DNMR Simulation  Runs DNMR3 as an external program. 

• Run MEXICO Simulation  Runs Alex Bain’s MEXICO program as an external program. 

• Run User Supplied External Simulation  This feature is under development, but it will 
allow users to add their own simulation modules. 

• Edit Simulation Parameters  This command starts a dialog where it is possible to edit the 
simulation parameters:  

• Display Linewidth (Hz.)  This is the linewidth (Lorentzian or Gaussian) used for 
in the calculation of the simulated spectrum. 

• Size (data points)  The number of points used in the calculation of the simulated 
spectrum.  The default value is 16k.  In an experimental spectrum has been read the 
size parameter from the experimental data will be used instead. 

• Grouping linewidth (Hz.)  The linewidth used for grouping near degenerate 
peaks in a peak listing.  This value does not normally need adjustment. 

• Display Width (Hz.) The width of the spectral window used to calculate the 
simulated spectrum.  If an experimental spectrum has been read, the spectral width 
parameter from the experimental data will be used instead. 

• Offset (leftmost frequency in Hz.)  The frequency of the left-most simulated 
data point in Hz.  If an experimental spectrum has been read, the corresponding 
parameter from the experimental data will be used instead. 

• Spectrometer Frequency (MHz.)  The frequency used to convert from Hz to 
ppm for the axis of the simulated spectrum. If an experimental spectrum has been 
read, the corresponding parameter from the experimental data will be used instead. 

• Transition Threshold  The minimum intensity for calculated transitions to be 
saved.  Too high a value may cause some small transitions to be missed.  Very large 
tightly coupled spin systems generate large numbers of very weak (usually 
unobservable) transitions.  Too low a value may cause transition table to overflow on 
these systems.  The default value of 0.01 is suitable for most cases. 

• Maximum number of iterations  Puts a limit on the number of iterations 
allowed in an iterative simulation.  The default value is 15. 

• RMS limit for convergence (Hz.)  An iterative simulation (optimization) will 
stop if the RMS deviation between the experimental and simulated peak frequencies 
falls below this level. 

• RMS level for autoassign (Hz.)  The RMS deviation must fall below this level 
for automatic assignment to occur.  The default is 0.1 Hz and the maximum value is 
10 Hz.  The default is suitable for high resolution spectroscopy and can be raised to 1 
to 2 Hz for more routine work. 
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• Allowable variation in pars  The allowable variation in a parameter during an 
iteration.  The default value is 25% and the minimum value is 1%.  This parameter 
rarely requires adjustment. 

• RMS factor for autoassign  Transitions with frequency differences within this 
factor times the current RMS deviation will be automatically assigned.  The default 
value is 2.7 and the minimum allowed value is 1.28.  This value must be less than the 
RMS factor for autoignore.  This parameter rarely requires adjustment. 

• RMS factor for autoignore  Transitions with absolute differences greater than 
this value times the current RMS deviation will be automatically ignored during an 
optimization.  The default value is 3, and the minimum allowed value is 1.6.  This 
parameter rarely requires adjustment. 

• Iterations between each autoassignment  The number of iterations between 
each autoassignment.  The default value of 3 rarely requires adjustment. 

• Optimize check box  Determines if an iterative simulation (optimization) should 
be performed.  The default value is OFF.  Make sure that you have selected some 
parameters for optimization (Spin System menu) and that you have assigned 
sufficient transitions before running an iterative simulation. 

• Autoassign check box  Determines if transitions should be automatically 
assigned during an optimization.  The default value is ON.  Note that using 
Autoassign too early in a difficult analysis can lead to problems. 

• Autoignore check box  Determines if transitions with excessively large 
deviations should be ignored (and possibly Autoassigned) during an optimization.  
The default value is ON.  This parameter should generally ALWAYS be left ON 
unless you really know what you are doing. 

• List Simulation Output  Starts an MS Notepad session with the textual output of the last 
simulation run.  Also, use this command to print the simulation output. 

• Autoassign Displayed Region  Automatically assigns the transitions to observed peaks in 
the displayed region. The peak picking threshold and sensitivity values are used for peak 
assignment.  If no observed peak can be found within a certain distance of the transition 
cursor, or if the peak is below the peak picking threshold or sensitivity, no peak will be 
assigned.  Single transitions can be assigned with the keyboard “a” key. 

• Delete Assignments in Displayed Region  Deletes all transition assignments in the 
displayed region.  Single transition assignments can be deleted with the keyboard “d” key. 

• Debug Mode  Turns on the simulation debug mode.  If this feature is turned on, a number of 
log files are dumped  during a simulation.  These files contain useful information in the event 
of difficulty.  The default setting is OFF.  If running a user-supplied external module the 
names of the input file, output file and the actual command line will be displayed as pop-ups 
while the external module is running. 
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Peak Pick Menu Commands (1D mode) 
• Pick Peaks and Append to List  Picks the peaks in the currently displayed region and 

appends them to the peak list.  The minimum intensity for peak picking is displayed as a 
dashed line across the screen and can be changed by dragging it with the small box displayed 
at the left end of the line.  This value, along with the noise discrimination parameter can be 
changed manually with the 1D Processing Parameters… dialog in the Edit menu. 

• Clear Peak List   Erases all of the picked peaks. 

• List   Displays the peaks in MS Notepad for possible printing. 

• Interpolation  Determines whether parabolic peak interpolation is to be used for the 
calibration and peak assignment routines.  If turned OFF the raw cursor frequency will be 
used instead.  The default value is ON. 

• Peak Pick (On Plot) Units.. Selects PPM or Hz as the units for the on-plot peak list and 
display.  This is independent of the axis units. 

• Calibrate…  Sets a particular peak or point in the spectrum to a particular shift.  Enter in the 
same units as the axis display.  Also available as a Toolbar button. 

Processing Menu Commands 
Note that the processing pop-up dialog (tool bar) provides a convenient alternative to many of 
the following menu commands. 

• ft  Performs a Fourier transform of the current fid. with no window function  Uses the Size 
parameter from the 1D Processing Parameters… dialog (Edit menu).  Usually, the em+ft 
command is more appropriate. 

• em+ft  Performs a Lorentzian broadening and Fourier transform of the current fid.  Uses the 
LB and Size parameters from the 1D Processing Parameters… dialog (Edit menu).  A 
typical value for LB is 1/(acquisition time) or equal to the natural linewidth if the peaks are 
broader than this value. 

• gm+ft  Performs a Bruker-style Lorentz to Gauss transformation and Fourier transform of the 
current fid.  Uses the LB, GB and Size parameters from the 1D Processing Parameters… 
dialog (Edit menu).  This function is normally used to provide resolution enhancement of the 
spectrum.  Typically, set LB to the negative of the observed linewidth and GB to the 
fractional point in the time domain where the signal vanishes into the noise.  e.g.  If the 
acquisition time is 5 seconds and the signal disappears into the noise by 2 seconds then GB 
should be set to 0.4.  These are only trial parameters, and may need to be readjusted to suit 
particular circumstances. 

• em+ft+last phase  Performs a Lorentzian broadening and Fourier transform of the current 
fid.  Uses the LB and Size parameters from the 1D Processing Parameters… dialog (Edit 
menu).  After transformation, the data are phase corrected with the last phase constants used 
by SpinWorks. 
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• gm+ft+last phase  Performs a Bruker-style Lorentz to Gauss transformation and Fourier 
transform of the current fid.  Uses the LB, GB and Size parameters from the 1D Processing 
Parameters… dialog (Edit menu). After transformation the data are phased with the last 
phase constants used by SpinWorks.  This function is normally used to provide resolution 
enhancement of the spectrum.  Typically, set LB to the negative of the observed linewidth 
and GB to the fractional point in the time domain where the signal vanishes into the noise.  
e.g.  If the acquisition time is 5 seconds and the signal disappears into the noise by 2 seconds 
then GB should be set to 0.4.  These are only trial parameters, and may need to be readjusted 
to suit particular circumstances.  Note that resolution enhancement may affect relative 
integrals 

• Gaussian + ft  Applies a Gaussian window function to the data followed by a Fourier 
transform.  Uses the LB and Size parameters from the 1D Processing Parameters… 
dialog (Edit menu).  

• last phase  Phase correct the data using the last phase constants used by SpinWorks.  This 
command is rarely used on its own, but more often in conjunction with other processing.  e.g. 
The em+ft+pk command. 

• Automatic Phase Correction  Uses a fast algorithm to automatically phase the spectrum.  
This feature is still under development, but works well for spectra with good baselines and 
good signal to noise ratio. 

• 2D Processing (sub menu)   Contains assorted 2D processing commands that are not 
included in the 2D Processing and Display dialog. 

• 2D Processing Dialog   Starts the pop-up 2D Processing and Display dialog.  This 
command is also available on the toolbar. 

• Smooth   Applies a smoothing algorithm to the data.  This command will improve S:N 
slightly and will “smooth-out” jagged contours.  Usually, time domain processing 
(adjusting window function, zero-filling, linear prediction, etc.) is preferred. 

• Baseline F2 and Baseline F1   Applies an automatic baseline correction to the rows or 
columns of the 2D matrix.  Rarely required when working in organic solvents, but may 
be useful for samples recorded in water. 

• Drift Correct F1 and F2  Apply a Varian style drift correction (first order baseline 
correction) to the rows or columns.  This is useful when some baseline flattening is 
desired but polynomial baseline correction is inappropriate. 

• Symmetrize    Applies a symmetrization algorithm to the data.  The data must be 
inherently symmetric.  That is, the size, spectral width and referencing must be identical 
in the two dimensions, as should be the case with COSY data. This routine is frowned 
upon by spectroscopists, but is still commonly used by organic chemists.  The chief 
problem is that it can turn an obvious artifact such as T1 noise or tailing into something 
that looks like a real cross peak.  Correcting the problem at source (vibration isolation, 
stable instrument environment, better phase cycling, using gradients, etc.) is a better if 
not always practical solution. 
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• Calculate F1 and F2 Projections  These commands calculate the F1 or F2 projections 
of the data, and save the projections in the current data folder as JCAMP-DX files with 
file names f1_proj.dx and f2_proj.dx.  An F1 projection of HSQC and/or HMBC data is 
particularly useful for samples that are too dilute for conventional 13C spectroscopy in a 
reasonable amount of time.  These commands are also available in the 2D Processing 
and Display Dialog.  When activated from this dialog, the projections will also be 
displayed along the edges of the 2D spectrum and can be printed with the 2D spectrum as 
well. 

• 2D Shearing Transform   Applies a T1 dependent first order phase correction to the 
rows of a 2D data set.  This transform is used to generate orthogonal MQ and MAS 
dimensions in a MQMAS experiment.  The phase angle requires depends on the spin of 
the nucleus and, the quantum selection of the experiment, and the spectral widths in both 
dimensions.  The shearing angle is most conveniently calculated using the MQMAS 
Toolbox…  Dialog (2D Processing sub-menu). 

• MQMAS Toolbox…   Use this dialog to calculate the required phase angle for the 2D 
Shearing Transform. 

• Auto Reference F1 An automatic referencing of F1 for many experiments can be 
accomplished using the Auto Reference F1 sub menu in the Processing menu. Select the F1 
nucleus and solvent appropriate to your data.  This procedure assumes that the F2 dimension 
is proton, and has been correctly referenced.  The reference values used are valid for dilute 
solutions at 25°C.  A homonuclear option will set the referencing in F1 to be the same as that 
in F2.  This command makes use of the constant ratio of the reference peak in proton vs. that 
of the X nucleus, for a given solvent and temperature. 

• Automatic Baseline Correction (least squares)  This command applies a polynomial 
baseline correction to the displayed region of the spectrum. The default polynomial order is 
3, and may be changed in the Edit Processing Parameters… dialog (Edit menu).  It is first 
necessary to define some baseline points.  This is accomplished by clicking on the yellow b 
pt button on the toolbar.  Then use the mouse to define at least six points in the displayed 
region that represent baseline.  More points are better, and it is important to include points 
near each end of the region.  Note that the baseline point routine averages a region 16 points 
wide, so don’t select points close to large peaks.  After selecting enough points, click on the 
pop-up return button to exit the baseline points routine.  Finally, execute the Automatic 
Baseline Correction (least squares) command. 

• Automatic Baseline Correction (SVD)  This command is similar to Automatic Baseline 
Correction (least squares), but uses a different (and generally inferior) algorithm for the 
polynomial fit.  The least squares version is usually preferred. 

• Fully Automatic Baseline Correction   Applies a least squares correction to the baseline, 
but determines the baseline points automatically.  This procedure works well for spectra with 
clear regions of baseline and a decent signal to noise ratio. 

• Clear Points   Clears the defined baseline points. 
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• HOGWASH    Applies Ray Freeman’s HOGWASH procedure to the displayed region of the 
spectrum.  The HOWGASH parameters must first be set (Edit menu).  Please see the 
HOGWASH section of this manual for details. 

• Subtract Trace 2 from Experimental  This command can be used to create a difference 
spectrum by subtracting trace 2 from the current experimental spectrum.  For example, to 
process an NOE difference experiment: 

1. Process the reference (off resonance) spectrum normally with the em+ft 
command (Processing menu) followed by phasing.  Do not apply baseline correction 
at this point. 

2. Transfer a copy of the processed reference spectrum to trace 2 with the Copy 
Experimental to #2 command in the View menu. 

3. Open one of the on-resonance NOE experiments (File menu) and process it with 
the em+ft+pk command (Processing menu). Do not use baseline correction. 

4. Use the Subtract Trace 2 from Experimental command (Processing menu) to 
replace the current experimental spectrum with the difference between the two.  If 
necessary, apply baseline correction now. 

5. Peak pick, integrate, and plot the difference spectrum as desired 

6. Repeat steps 3 to 5 for each of the on-resonance NOE experiments in the run. 

7. Anyone with gradients will, of course, be using the GOESY experiment instead. 
☺ 

• Reverse Spectrum  This command reverses the spectrum – high field to low field.  There 
are several circumstances where this may be appropriate: 

1. On some older Bruker spectrometers, fluorine spectra are reversed.   

2. Exchange of the two quadrature channels will reverse the spectrum (This is the 
default state on Varian and JEOL spectrometers. Therefore, Varian and JEOL data 
are automatically reversed by SpinWorks). 

3. If a spectrum has a distinct baseline curvature at the left (low field) end of the 
spectrum, it is possible to straighten it by reversing the spectrum, using the automatic 
baseline routine, and then reversing the spectrum back to the normal orientation. 

Commands Available with the Command Line 
Processing Commands: 
The following commands can be used to process 1D data.  Many of the commands require that 
the appropriate processing parameters (e.g. LB or GB) be set first.  This can be most easily done 
with the 1D Processing Parameters dialog (Edit menu or edp command), or by giving one of 
the parameter commands listed below. 

• em  Exponential multiplication of the fid (uses LB parameter). 
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• gm  Bruker type Gaussian multiplication (resolution enhancement) of the fid  (uses LB 
  and GB parameters). 

• traf  Apply TRAF function to fid (uses  LB parameter). 

• trafs Apply TRAFS function to fid (uses  LB parameter). 

• lpf  Forward linear prediction of fid.  Uses the LP parameters in the Processing  
  Parameters dialog (Edit menu).  Note that forward linear prediction of 1D data,  
  and arguments with furniture, are rarely productive. 

• lpb  Backward linear prediction of fid.  Uses the LP parameters in the Processing  
  Parameters dialog (Edit menu). 

• ft  Fourier transform of fid. 

• ef  Exponential multiplication followed by Fourier transform. 

• efp  Exponential multiplication followed by Fourier transform and phase correction  
  with previous phase constants. 

• gf  Gaussian multiplication followed by Fourier transform. 

• gfp  Gaussian multiplication followed by Fourier transform and phase correction with  
  previous phase constants. 

• trafft TRAF function followed by Fourier transform. 

• trafsft TRAFS function followed by Fourier transform. 

• pk  Apply previous phase constants. 

• apk Automatic phase correction. 

• abs Automatic baseline correction using a least squares fit.  Requires defined baseline 
   points and use parameters in the Processing Parameters dialog (Edit 
menu). 

• fabs Automatic baseline correction with automatic selection of the baseline points. 

• rev  Reverse spectrum, low field to high field. 

• hw  HOGWASH enhance the displayed region of the spectrum.  You must define the  
  parameters in the HOGWASH Parameters dialog (Edit menu or edhw)  first.   
  Alias: hogwash 

File Handling Commands 
• open Opens a new NMR data set. 

• re # Reads experiment number # for UXNMR/XwinNMR data only.  For example, If  
  you are currently working on the proton spectrum mydata/1 and you want to  
  switch to the carbon spectrum mydata/4, using the command re 4 will switch  
  you to the carbon data set without going through the file open dialog.  Alias: read 
  # 
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Simulation Commands 
The following commands can be used to run the various SpinWorks simulation routines.  The 
program must be in the correct mode (NUMMRIT or DNMR/MEXICO) before running the 
simulation, and you must edit the parameters first (Spin System or Simulation menus). 

• sim Run a NUMMRIT simulation. 

• dnmr Run DNMR simulation. 

• mexico Run MEXICO simulation. 

Parameter Editing Commands: 

• edproc Edit processing parameters (1D and 2D).  Alias: edp. 

• edhw Edit HOGWASH parameters. 

• edshifts Edit the chemical shifts for a simulation. 

• edj  Edit scalar coupling constants for a NUMMRIT or DNMR simulation. 

• edd Edit dipolar couplings for a NUMMRIT simulation. 

• edsim Edit general simulation parameters for a simulation. 

• eddnmr Edit DNMR/MEXICO specific parameters. 

• edmch Edit or inspect the MEXICO mechanism file (rarely needed). 

Options Commands: 
These commands duplicate most of the commands in the Options menu. 

• vnmr Switches to Varian VNMR mode.  Alias: varian 

• xwinnmr Switches to Bruker XwinNMR/UXNMR mode.  Aliases: bruker, uxnmr 

Parameters that Can be Set with the Command Line: 
Many SpinWorks parameters can also be entered on the command line.  They are entered by 
typing the number followed by the value.  e.g. lb 1.2 changes the value of the LB parameter to 
1.2 Hz. 

• lb  Exponential line broadening, in Hz. 

• gb  Gaussian broadening factor (Bruker style). 

• size Transform size in complex points.  i.e. 8182 means 8192 real points plus 8192  
  imaginary points. Aliases: si, fn 

• ph0 Zero order phase constant. Alias phc0. 

• ph1 First order phase constant. Alias phc1. 

• vscale Sets the vertical scaling of the spectrum.  The current vertical scaling is shown  



 
Kirk Marat Page 77 7/23/2005 

  just below the axis at the right side of the screen. Alias: vs 

SpinWorks Bug and Revision History (Earlier Releases) 

Pre version 1.2 

1. Failure to read Varian floating point and 16 bit integer FIDs due to problems with Sun to 
Intel byte swapping routine.  Fixed in 99 11 08 a. 

2. Files of type… drop-down blank in File Open and Save boxes, causing user confusion.  
Changed to show: “all files (*.*)” and to display the current data format in File Open box in 
2000 02 18. 

3. Integral region list was retained upon reading new file.  This was changed to clear the 
integral regions as of 2000 02 18. 

4. Added dipolar couplings 2000 02 18. 
5. Negative couplings or shifts not optimized properly. Fixed in 2000 05 08. 
6. Problems with optimizing dipolar couplings.  Fixed in 2000 05 08. 
7. Would not detect Bruker DSP data if AQ_mod was set to qsim rather than DQD, even 

though DIGMOD was set to digital.  Editing of the processing parameters to set the DSP flag 
was then necessary.  Fixed in 2000 05 08. 

Version 1.2 

1. DNMR3 and MEXICO now included as external modules. 
2. JEOL (generic) and TECMAG (NTNMR) data format now supported. 

Version 1.3 

1. Saving (and reading) of 1D spectra in JCAMP-DX format now included. 
2. Inset expansion box added. 
3. Zooming with middle mouse button added. 
4. Axis tic spacing increases for large numbers (to avoid overlap of the labels if axis values 

have numbers like –87200 Hz. 
5. Processing pop-up dialog box (button panel) added. 
6. TRAF and TRAFS apodization functions added. 
7. DNMR3 re-compiled with double precision (64 bit) floating point variables. 
8. A problem with printing if C:\Temp didn’t exist was fixed. 
9. J editor increased to include all possible couplings from a 9 group system. 
10. User supplied external simulation routines are supported (read the manual carefully!) 
11. Small bug with simulation parameter editor (linking of SF and SW) fixed.  You can now 

change the SF without the program changing SW to be the same range in ppm. The SW is 
now constant in Hz, even if you change SF. 

12. Simulation pop-up dialog box (button panel) added. 
13. Fixed a bug that caused SpinWorks to crash if a MEXICO simulation failed.  A proper error 

message is now provided. 
14. RMS deviation is now displayed on the screen after an iterative NUMMRIT simulation or a 

DNMR/MEXICO simulation. 
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15. Summing of simulated spectra into trace 2 added. 
16. Fixed bug with MetaFile axis and cleaned up the MetaFile handling a bit. 

Version 2.0  

1. The scalar and dipolar coupling editors have been expanded to handle all possible couplings 
from 10 spins. 

2. Assorted small bugs fixed. 
3. Input (user) errors in the simulation routines handled more gracefully.  For example, a 19 

spin system will abort with an error message rather than crash SpinWorks. 
4. Problems with crashes when writing metafiles to the clipboard in Win XP fixed. 
5. 2D processing of Bruker and Varian data - at "alpha" test level!  Expect bugs.  Expect giant 

mutant cockroaches! 
6. Added fully automatic baseline correction.  For most data sets, it is now not necessary to 

define baseline points - the program will find them automatically. 
7. Mouse wheel support for vertical scaling added. 
8. Left shift processing parameter added. 

Version 2.1 

1. The contouring routines have been improved.  In 2D image mode, bi-cubic spline 
interpolation is used at high expansion levels. (displayed window smaller than 512 by 256 
data points). 

2. Extracted rows or columns of a 2D data set can be saved as JCAMP-DX data sets for 
viewing in 1D mode.  Individual extracted rows or columns can be selected and viewed in 
1D mode and can be scaled separately. 

3. Assorted small bug fixes. 
4. Fixed automatic detection of Varian echo-antiecho data. 
5. Fixed bug with linear F1 prediction of Varian data. 
6. TECMAG 2D data format included (at test level).  
7. HOGWASH available in F1 of 2D data sets. 
8. Linear prediction routines improved.  LP (forward and back) included for 1D. 

Version 2.2 

1. Added rudimentary command processor. 
2. Added first point multiplier parameter for 2D. 
3. 2D Spectra can be plotted in a square format with parameters at the right side of the 

spectrum.  A grid can be included on a 2D plot. 
4. The integral and peak pick listings now display an absolute intensity as well as a relative 

intensity.  This can be used to compare intensities between spectra. 
5. Drift correction (offset and slope) baseline correction has been added to 2D processing.   
6. 2D Spectra can be plotted in a square format with parameters at the right side of the 

spectrum.  A grid can be included on a 2D plot. 
7. The tracking cursor (or 2D cross-hair cursor) can be toggled on and off by double-clicking in 

the data window. 
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8. A link (button) to the 2D parameter editor has been added to the 2D processing and display 
dialog. 

9. A link (button) to the 1D parameter editor has been added to the 1D processing dialog. 
10. Negative contours can be printed in colour, if you have a colour printer. 
11. Changed LP routine and fixed a bug with magnitude mode data.   
12. Fixed a bug in 2D HOGWASH that caused it to fail on magnitude mode data. 
13. Improved reference parameter extraction for Varian 2D data.  SpinWorks now checks the 

“refsource” parameter for proper conversion of Hz to ppm. 

14. Integration regions are saved as a disk file. 

Version 2.3 

1. Added interactive trace (slice) display. 
2. External 1D or 2D traces are now drawn so that they do not overlap the 2D drawing area. 
3. Contouring much speeded up (by a factor of about 3) and improved (smoother). 
4. Fixed much of the left-over tracking cursor problem. 
5. Fixed numerous problems (crashes) resulting if size in F1 was smaller than the number of 

time domain points in F1.  There is no logical reason to ever do this, but it has been fixed 
anyway. 

6. Zhu-Bax “forward-backward” linear prediction has been added. 
7. A solvent (high-pass) filter has been added. 
8. Assorted small bug fixes. 
 
Version 2.3.2 

1. Buttons to correct problems with Varian’s “refsource1” parameter added to the F1 processing 
panel. 

2. Auto referencing of F1 added to Added to Processing menu. 
3. Corrected bug in processing Varian 2D data when the acquisition has been stopped before 

“in” increments have been finished. 



 
Kirk Marat Page 80 7/23/2005 

Index 
2D MQ MAS ...........................................................27 
2D processing 

2D display...........................................................28 
baseline correction ..............................................31 
F1 referencing.....................................................32 
F2 and F1 reference spectra .................................31 
F2 and F1 traces..................................................32 
introduction.........................................................22 
phasing................................................................30 
projections ..........................................................32 
selecting the 2D data set .....................................23 
setting the 2D processing parameters .................23 
transform.............................................................27 

2D Processing (sub menu) 
Processing menu...............................................71 

2D Processing Dialog 
Processing menu...............................................71 

2D Processing Parameters 
Edit menu............................................................62 

2D processing tutorial..............................................34 
2D Shearing Transform........................................72 
ABC: effect of T1 relaxation 

MEXICO ............................................................57 
ABS Poly. Degree .................................................61 
ABX 

simulation ...........................................................38 
acknowledgements ....................................................7 
Acquisition Mode...................................................62 
Add Simulated to #2 

View menu..........................................................63 
Alex Bain...........................................7, 50, 51, 52, 68 
Allowable variation in pars 

Simulation Parameters dialog .............................68 
arguments with furniture .........................................73 
Auto Reference F1

Processing menu...............................................72 
Autoassign 

Simulation Parameters dialog .............................69 
Autoassign Displayed Region 

Simulation menu and "a" key ............................69 
Autoignore 

Simulation Parameters dialog .............................69 
Automatic Baseline Correction (least squares) 

Processing menu...............................................72 
Automatic Baseline Correction (SVD) 

Processing menu...............................................72 
Automatic Phase Correction 

Processing menu...............................................71 

automatic referencing of F1 ...............................33, 72 
Backwards Linear Prediction 

1D processing parameters...................................62 
baseline correction 

1D .......................................................................17 
2D .......................................................................31 

Baseline F2 and Baseline F1 
Processing menu...............................................71 

baseline offset 
spectrum..............................................................14 

bug and revision history ..........................................75 
Calculate F1 and F2 Projections 

Processing menu...............................................71 
Calibrate 

Peak Pick menu.................................................70 
Clear Peak List 

Peak Pick menu.................................................70 
Clear Points 

Processing menu...............................................72 
clipboard............................................................60, 76 
computer requirements ..............................................6 
Copy Experimental to #2…#4 

View menu..........................................................63 
Copy Metafile to Clipboard 

Edit menu ...........................................................60 
Copy MetaFile to File 

Edit menu ...........................................................60 
Copy Simulated to #2…#4 

View menu..........................................................63 
Copy Simulated to Experimental 

View menu..........................................................63 
COSY ................................................5, 25, 27, 34, 71 
data format 

setting the............................................................13 
Data Format 

Options menu.....................................................64 
data on CD................................................................14 
DC bias 

FID......................................................................14 
Debug Mode 

Simulation menu................................................69 
default data directory...............................................23 
Delete Assignments in Displayed Region 

Simulation menu and "d" key ............................69 
Delete Processed Data 

File menu ............................................................60 
Delete Trace #2…4 

View menu..........................................................64 



 
Kirk Marat Page 2 7/23/2005 

Detection Mode 
2D parameters .....................................................23 

DISNMR..................................................................13 
Display buffer exceeded ............................................6 
Display Linewidth (Hz.) 

Simulation Parameters dialog .............................68 
display manipulation..................................................9 
Display Width (Hz.) 

Simulation Parameters dialog .............................68 
DNMR tutorial.........................................................55 
DNMR3 

introduction to.....................................................50 
download ...................................................................6 
Drift Correct F1 and F2 

Processing menu...............................................71 
Dynamic NMR simulation 

introduction.........................................................50 
echo-antiecho...........................................5, 22, 23, 36 
Edit Chemical Shifts 

Spin System menu ............................................66 
Edit Dipolar (D) Couplings 

Spin System menu ............................................67 
Edit DNMR Parameters 

Spin System menu ............................................67 
Edit menu commands ..............................................60 
Edit Quadrupolar (Q) Couplings 

Spin System menu ............................................67 
Edit Scalar (J) Couplings 

Spin System menu ............................................67 
Edit Simulation Parameters 

Simulation menu................................................68 
Edit Species Spin Values 

Spin System menu ............................................67 
em+ft 

Processing menu...............................................70 
em+ft+pk 

Processing menu...............................................70 
example files 

for DNMR3 and MEXICO .................................53 
F1 Referencing 

homily .................................................................32 
f1coef 

Varian 2D ...........................................................34 
Varian 2D data....................................................36 

F2 and F1 Traces 
2D Display..........................................................32 

File Handling Commands 
command line......................................................74 

File menu commands...............................................58 
Find Cursor 

button ..................................................................52 

First Order Phase..................................................61 
first point correction 

DC offset caused by............................................31 
First Point Correction ..............................................24 
fluorobenzene 

simulation and analysis .......................................40 
Forward Linear Prediction (1D)..... See: Arguments 

with furniture 
Fourier transform.....................................................70 

Processing menu...............................................70 
frequency 

display of ..............................................................9 
Frequency of 0 ppm 

2D parameters .....................................................23 
Frequency of 0 ppm (MHz)..................................61 
ft 

Processing menu...............................................70 
Fully Automatic Baseline Correction 

Processing menu...............................................72 
Gaussian 

window function .................................................16 
Gaussian window function 

Processing menu...............................................71 
GB .........................................................14, 24, 61, 70 
gm+ft 

Processing menu...............................................70 
gm+ft+pk 

Processing menu...............................................70 
Grouping linewidth (Hz.) 

Simulation Parameters dialog .............................68 
Hint 

running 2 copies of SpinWorks ..........................30 
HOGWASH 

2D .......................................................................45 
2D parameters .....................................................25 
Processing menu...............................................72 

HOGWASH (1D) 
example...............................................................45 
introduction to.....................................................42 

HOGWASH Parameters 
Edit menu............................................................62 

homily 
HOGWASH........................................................42 

HSQC ........................................................5, 6, 36, 38 
Hypercomplex .........................................................22 
installation .................................................................6 
integration 

1D .......................................................................18 
Interpolation 

Peak Pick menu.................................................70 
Iterations between each autoassignment 



 
Kirk Marat Page 3 7/23/2005 

Simulation Parameters dialog .............................69 
JCAMP-DX .....................................31, 32, 44, 59, 76 
JEOL............................................................13, 64, 76 
K(1,2) 

DNMR rata constant ...............................53, 54, 55 
Keyboard 

arrow keys...........................................................10 
function summary ...............................................10 

LB ........................................14, 15, 24, 45, 61, 70, 71 
TRAF function....................................................15 

LB parameter 
Gaussian window function .................................16 

Left Shift FID ..........................................................61 
linear prediction 

1D .......................................................................16 
2D .......................................................................24 

Linear Prediction 
2D parameters .....................................................24 

LINUX VNMR 
block header problem ...........................................8 

List 
Peak Pick menu.................................................70 

List Simulation Output 
Simulation menu................................................69 

Load Optimized Parameters 
Spin System menu ............................................67 

Lorentzian broadening.............................................70 
magnitude COSY spectrum.....................................34 
Magnitude mode......................................................22 
Maximum number of iterations 

Simulation Parameters dialog .............................68 
menu bar commands................................................58 
Menu Bar Commands 

summary .............................................................58 
metafiles ..................................................................76 
MEXICO 

introduction to.....................................................51 
mouse.........................................................................9 
MQMAS Toolbox...................................................72 
mutual exchange 

AB to BA ............................................................55 
ABC to BAC.......................................................56 
DNMR ........................................51, 53, 54, 55, 57 

Mutual Exchange 
checkbox (DNMR) .............................................54 

NOE difference experiment.....................................72 
Offset (leftmost frequency in Hz.) 

Simulation Parameters dialog .............................68 
Online Help ...............................................................7 
Open 

File menu ............................................................58 

Optimize check box 
Simulation Parameters dialog .............................69 

Option menu commands..........................................64 
Options Commands 

command line......................................................75 
ortho-dichlorobenzene 

simularion and analysis.......................................39 
Parameter Editing Commands 

command line......................................................75 
parameters 

DNMR ................................................................54 
Parameters 

command line......................................................75 
Peak Pick (On Plot) Units 

Peak Pick menu.................................................70 
Peak Pick menu .....................................................69 
Peak Pick Minimum Intensity ..............................61 
Peak Pick Noise Threshold .................................61 
peak picking .....................................11, 19, 39, 61, 69 

1D .......................................................................19 
Peaks and Match 

Options menu.....................................................64 
permutation vectors 

DNMR ................................................................54 
phase parameter 

Varian 2D data..............................................34, 36 
phasing 

1D .......................................................................17 
2D .................................................................25, 30 

Phasing 
2D parameters .....................................................25 

phasing data 
1D .......................................................................17 

Pick Peaks and Append to List 
Peak Pick menu.................................................69 

pk 
Processing menu...............................................71 

Plot Options and Parameters 
Edit menu ...........................................................62 

Plot Title ..................................................................19 
Edit menu ...........................................................62 

Print 
File menu ............................................................60 

Print Preview 
File menu ............................................................60 

Print Setup 
File menu ............................................................60 

printing ........................................................19, 20, 29 
Processing Commands 

command line......................................................73 
Processing menu commands .................................70 



 
Kirk Marat Page 4 7/23/2005 

processing parameters 
1D .......................................................................14 
2D .......................................................................23 

Processing Parameters 
1D .......................................................................61 

rate constants 
DNMR ................................................................54 

Read Assigned Transitions 
File menu ............................................................60 

Read Spin System File 
File menu ............................................................59 

recently used file list 
File menu ............................................................60 

redistribution .............................................................7 
refsource1 parameter ...............................................32 
registration.................................................................7 
relaxation 

DNMR3 vs. MEXICO ........................................53 
Requirements.............................................................6 
Reverse 

2D parameters .....................................................23 
Reverse Spectrum 

Processing menu...............................................73 
RMS factor for autoassign 

Simulation Parameters dialog .............................69 
RMS factor for autoignore 

Simulation Parameters dialog .............................69 
RMS level for autoassign (Hz.) 

Simulation Parameters dialog .............................68 
RMS limit for convergence (Hz.) 

Simulation Parameters dialog .............................68 
Rotate 2D 

View menu..........................................................63 
Run DNMR Simulation 

Simulation menu................................................68 
Run MEXICO Simulation 

Simulation menu................................................68 
Run NUMMRIT Simulation 

Simulation menu................................................67 
Run User Supplied External Simulation 

Simulation menu................................................68 
Save and Save as 

File menu ............................................................59 
Save Assigned Transitions As 

File menu ............................................................60 
Save Extracted Rows or Columns 

File menu ............................................................59 
Save Spin System As 

File menu ............................................................60 
Scale/Shift Stacked or Inset Traces 

View menu..........................................................63 

Select Block (Varian) 
File menu ............................................................59 

Set Fixed Limits and Set Fixed Scale 
View menu..........................................................63 

Set Preferences 
Options menu.....................................................65 

shearing transform 
2D MQ MAS ......................................................27 

Show Inset Box 
View menu..........................................................63 

Show Simulated 
View menu..........................................................63 

Simulation Commands 
command line......................................................74 

Simulation menu.....................................................67 
Simulation Mode 

Options menu.....................................................64 
Simulation Tutorial..................................................38 
Size 

2D parameters .....................................................23 
parameter ......................................................61, 70 
Simulation Parameters dialog .............................68 

Smooth 
Processing menu...............................................71 

Solvent Filter 
1D processing parameters...................................61 
2D parameters .....................................................25 

Spectrometer Frequency (MHz.) 
Simulation Parameters dialog .............................68 

spectrum.dx .............................................................11 
Spin System menu commands...............................66 
States ...................................................5, 6, 22, 23, 36 
States-TPPI ..............................................5, 22, 23, 36 
Status Bar 

View menu..........................................................62 
Subtract Trace 2 from Experimental 

Processing menu...............................................72 
Symmetrize 

Processing menu...............................................71 
T1 relaxation 

MEXICO ............................................................57 
T2 (for DNMR3) or T1 (for MEXICO) ..................54 
Toolbar ....................................................................11 

View menu..........................................................62 
TPPI.........................................................5, 22, 23, 36 
Tracking Cursor 

Options menu.....................................................64 
TRAF 

resolution enhancement ......................................15 
TRAF function .........................................................15 
TRAFS function .......................................................16 



 
Kirk Marat Page 5 7/23/2005 

truncation artifacts 
removal with 2D HOGWASH............................45 

user supplied external modules................................57 
View menu commands ............................................62 
VNMR.................................................5, 7, 30, 31, 75 
vscale 

command.............................................................75 
Window Function 

2D parameters .....................................................24 
Zero Order Phase .................................................61 
zero-filling 

Size parameter ....................................................61 
Zhu-Bax 

linear prediction ..................................................24 
 


	 Introduction 
	What is SpinWorks 
	Computer Requirements 
	Download 
	Installation 
	Redistribution 
	Registration 
	Acknowledgements 
	Obligatory Disclaimer  
	Online Help 
	What’s New in Release 2.4 
	Added or fixed at PL5 
	New in Version 2.5 
	Use of the Mouse, and General Display Manipulation 
	Keyboard Arrow Keys 
	Keyboard Function Summary 
	Toolbar 
	Getting Started: Basic 1D NMR Processing 
	1.  Setting the Data Format 
	2.  Selecting the Data 
	3.  Processing Data 
	4.  Linear Prediction 
	5.  Phasing Data 
	6.  Baseline Correction 
	7.  Integration 
	8.  Peak Picking 
	9.  Printing 
	10.  Printing to a MetaFile 

	 
	11.  JEOL Data 

	2D Processing 
	Introduction to 2D Processing 
	Selecting the 2D Data Set 
	Setting the 2D Processing Parameters 
	Processing 2D Data 
	Transform  
	2D Display 
	Phasing 
	Baseline Correction 
	F2 and F1 Reference Spectra 
	Projections 
	F2 and F1 Traces (Scanning) 
	F1 Referencing 
	2D Integration 


	2D Processing Tutorial 
	Magnitude (COSY type) Data 
	Phase Sensitive (HSQC type) Spectra 

	Simulation Tutorial 
	ABX Spectrum 
	Analysis of the Ortho-dichlorobenzene Spectrum 
	Analysis of the Fluorobenzene Spectrum 

	HOGWASH Resolution Enhancement 
	General Comments 
	Using the Technique 
	Mask Peak Information 
	Loop Gain and Threshold  
	The Reconstruction Line Width 
	Starting the Calculation 
	Saving Enhanced Spectra 
	Speed 
	Application of HOGWASH Processing to the Indirect Dimension (F1) of 2D Spectra 
	2D HOGWASH Parameter Selection 
	Using the Technique 

	Dynamic NMR Simulation 
	DNMR3 
	MEXICO 
	General Notes on DNMR3 and MEXICO 
	Treatment of Relaxation 
	Example Files 
	Parameters Required for DNMR Simulation 
	DNMR Tutorial 
	AB(BA Mutual Exchange 
	ABC ( BAC Mutual Exchange 
	ABC: Effect of T1 Relaxation (MEXICO) 
	AB to CD Non Mutual Exchange 


	Running User Supplied External Modules 
	Summary of Menu Bar Commands 
	File Menu Commands 
	Edit Menu Commands 
	View Menu Commands 
	Option Menu Commands 
	Spin System Menu Commands 
	Simulation Menu Commands 
	Peak Pick Menu Commands (1D mode) 
	Processing Menu Commands 

	Commands Available with the Command Line 
	Processing Commands: 
	Simulation Commands 
	Parameter Editing Commands: 
	Options Commands: 
	Parameters that Can be Set with the Command Line: 

	SpinWorks Bug and Revision History (Earlier Releases) 
	Pre version 1.2 
	Version 1.2 
	Version 1.3 
	Version 2.0  
	Version 2.1 
	Version 2.2 
	Version 2.3 
	Version 2.3.2 




	 Index 


